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New Features in Version 2.50
The new version 2.50 contains more than 40 new features, bug fixes, better sync functions, 
scrubbing, varipitch, freehand waveform drawing and much more!

More stabile master sync
Samplitude supports sync output (MIDI Clock and MIDI Time Code).
The sync output is now directly coupled to the Wave output of the sound card, so there 
should be no
delays between Wave playback and the synchronized device.
The new sync is especially designed for using with a MIDI sequencer, which runs in 
multitasking on
the same machine as Samplitude, e.g. Cakewalk or Q-Trax.
Use a virtual MIDI driver like MIDIMUX or Multi-MPU for the internal link between Samplitude 
and the
MIDI sequencer!
When ever possible use MTC sync with e.g. 25 frames per second, so you need not to care 
about the
tempo of the sequencer!
When using the master sync features, please set the FX factor to 1.0.
For best performance of the audio/MIDI sync switch off the virtual memory!

Slave Sync with chase lock option
Samplitude supports now real chase lock sync (MIDI Clock and MIDI Time Code/SMPTE).
This means, that the internal sample rate of Samplitudes playback or recording is variied in 
small
steps, so that Samplitude can follow little timing changes of the sync master.
This is very useful when using sync between a tape or video recorder (master) and 
Samplitude (slave),
because most tape machines always produce small pitch changes, which results in delays 
between
the tape and Samplitude, when not using chase lock sync. If the timing changes are too big,
Samplitude produces heavy pitch changes, which may be reduced by entering smaller 
values for the
Sync Velocity in the sync dialog. Try values of 200 or more, when you need fast pitch 
changes in sync
mode! In the lower right status bar you can read the actual/maximal pitch change in cents 
( 1 cent =
1/100 halftone).
Please know, that the chase lock sync performes a real time resampling, which needs a 
certain
processing power, so be carefully on slow machines!
When receiving SMPTE/MTC you can start and stop playback with the space key - Samplitude
will
always be in sync!

Scrubbing
While pressing the Insert key and moving the mouse you can perform scrubbing. Samplitude
starts
playback at a very low speed, the mouse position relative to the start cursor controls the 
speed.
There are two scrubbing modes (in playback parameter window - key p):
Relative: The distance between the playback cursor and the mouse sets the playback 
speed.



Absolute: The position of the mouse in the window sets the playback speed - at the left 
border
playback speed is 200% backward, at the right border speed is 200 % forward, in the middle
of the
window the speed is 0.
There is a real time resampling performed for changing the playback rate without changing 
the sample
rate of the sound card. For best performance use small play buffer sizes and a fast processor
(Pentium recommended) !

Varipitch
Samplitude supports smooth changes of the pitch while playback, even in multi track 
projects (vertical
slider in playback parameter window - key p).
Activate the Varispeed mode with the "active" button, then you can change the playback 
speed in
various kinds:
Vertical slider - Changes the playback speed from -200% to +200%
Pitch Factor - Lets you specify a certain pitch factor manually
Halftones    - Lets you specify a value of halftones. The playback will be transposed the 
number of
halftones.
Internal Rate - Here you can set a sample rate for the varipitch calculation. If you want to 
play a wave
file with a sample rate of 48 KHz but your sound card can only play rates up to 44.1 KHz 
simply set the
internal rate to 48 and activate varispeed. You listen the same result as playing with real 48 
KHz!
This function is also very useful for digital playback to DAT with 44.1 KHz samples and and 
vice versa!
BPM - Here you can type in the original bpm value of your material and a destination bpm 
value, which
is reached using the varipitch.
Important: Varipitch works also while recording! So you can set the pitch to -2 halftones, 
sing a song
into the computer, then switch off the varipitch - your track is transposed two halftones 
higher!
There is a real time resampling performed for changing the playback rate without changing 
the sample
rate of the sound card. For best performance use small play buffer sizes and a fast processor
(Pentium recommended) !

Freehand Drawing
In virtual projects you can open a pop-up menu with the right mouse button, when clicking
beside the
volume sliders. Select "Draw Volume" to test the draw function. Select the "V" button before 
to activate
the volume rubberbands, then draw your own fade curve!
In physical projects you can also activate freehand drawing functions with the menu 
"Setup >
HDP/RAP mouse mode". Select here "Draw Wave" for freehand editing your samples. Select 
a zoom
level of 1:1 or larger for exact manipulation of your material. This is very powerful to correct 
small
distortions, pops etc...



If you select "Draw Volume" you can draw the volume of your material, this is useful for 
creating
special envelopes etc...
The bottom edge means volume factor 0 (silence), the upper edge means factor 2.

Transport Control Window
Samplitude now contains an easy to use transport control window, which lets you activate all
the play,
stop, record and position commands!
Open the transport window with the menu "Window > Transport Control"

Time Display Window
There also exists a new time display window, which informs you about the actual position 
while
playback or editing functions!
You can zoom the time display to any size and position it where you want- so you can read it 
even
from a large distance.
Open the time display window with the menu "Window > Time Display"

Playback Control in Windows menu
The playback parameter window (key p) is now located in the Windows menu.

Vertical Zoom function in virtual projects
With the vertical cursor keys you can zoom the waveform display in virtual projects 
vertically. This
makes it easy to arrange audio data with a low volume visually.

Soft Scroll Mode
The Play Parameter window (key p)    contains a modified auto scroll mode (soft), which lets 
the
playback cursor stay in the centre of the screen and the waveform display scrolls from right 
to the left.
Using a fast graphics board and small buffer sizes this mode produces a very smooth 
display!
When using the grid you get a slower screen refresh.
Choose the page mode or switch autoscroll off if the refresh is too slow and produces errors 
while
playback.

8 Setup buttons in VIPs
The 8 lower left buttons in a VIP store 4 setups (S1...S4 incl. zoom level, position and display 
mode)
and 4 zoom levels (Z1...Z4). So you can quickly switch f.e. between a full size display, a 10 
seconds
zoom range and a sample exact zooom level for perfect editing!

4 default Zoom Levels
In the bottom toolbar you find 4 buttons which set the zoom level to 0.1, 1, 10 and 60 
seconds.�

Zoom In/Out by dragging the scroller
There is a new way of zooming in and out: Simply drag the left or right border of the 
scrollbar button
with the mouse. If the "change mouse" mode is activated in Shift-Tab dialog, the mouse 



pointer
becomes an left-right-arrow, if you are above the position for the zoom function!

LED level meters
Each track in a VIP has its own exact LED level meter. Switch this function on or off with the 
menu
"Setup > VIP Display Preferences" or with the Shift + Tab key.
The level meters work both while recording and playback and store the maximum level 
(peak hold
function).
Important: Because drawing of    all the LEDs in a multi track VIP needs some processing 
time, switch
them off, when your machine is too slow!

New volume settings in VIPs
New virtual projects now get the following bit shifts (1 bit less than former versions):
1,2,and 4 tracks mono and 1 and 2 tracks stereo: 0 dB
8 tracks mono and 4 tracks stereo: -6 dB (1 Bit)
16 tracks Mono and 8 tracks stereo: -12 dB (2 Bits)
The default volume silder position is -6 dB for each track.
Please know, that this setting has no safe volume reserve, if you increase the volume level 
with the sliders you may produce clipping, if the material has maximum level on all tracks.
You can change the volume settings in the dialog Project > Project Information or with the i 
key!

Abort physical sample manipulations with ESC key
The ESC key lets you abort a physical sample calculation like EQ, Compression etc...

Remove DC offset
This function in menu "Edit" removes a DC offset in the marked range of a physical project 
(RAP or
HDP). Some sound cards produce such a DC offset while recording, so it is useful, if you can 
remove
it!

Parametric EQ with +/- 20 dB per band
The parametric EQ can now perform an amplification of +/- 20 dB per band. This makes it 
more
powerful for editing the sound of your material!

Move all objects and volume points behind actual position (key m)
While pressing the m-key you can move all objects and volume rubber points behind the 
actual cursor
position with the right mousebutton. This makes it easy to create free space in a VIP or re-
arrange
large projects without the need of grouping objects!

Move objects vertically with Shift + right mouse button
Using the shift key while moving objects with the right mousebutton you can only move the 
objects vertically. This makes it easy to move objects to another track without to change the 
timing position.

Change Mouse Cursor
This option in menu "Setup > VIP Display Preferences" or Shift + Tab key lets the mouse 
cursor



change to arrows, if you use the object mode in VIPs. It changes to a pencil if you activate 
the draw
mode for volume curves.

New Object Mode
This option in menu "Setup > VIP Display Preferences" or Shift + Tab key changes the way 
Samplitude
handles objects in a VIP: In the new mode the first right click only activates objects without 
the
"danger" of moving them. The next click can be used for move or drag objects or their 
handles!

Copy As function
The Copy As function in menu "Cut" lets you copy a marked range in a physical project into a
new file,
without the need of renaming the clipboard.

Save Complete VIP
This function in menu "Project" allows saving a VIP with all needed projects (HDPs, RAPs) into
a
specified directory. This makes it easy to copy all files of a VIP to a backup disk etc...

Save Session saves all projects
The Save Session command in menu "Project" now also saves all included projects. So you 
get after
recalling the session the actual versions of all projects!

Move Objects
The move objects function lets you quickly move an object in a VIP to a specified position.

Object Editor
The object editor lets you select the curve types of the object fades (fade in and fade out). 
So you can
give the fades any curve type from logarithmic to exponential.
Activate the object editor with the menu "Object > Object Editor" or with a right + left 
mouse click on
the object!

Cursors on Silence
This function automatically sets cursors on silent positions in the waveform. You can specify 
the
minimal length of the pause and a threshold level.

Moving Range Borders with the / * - + keys
The / * - + keys of the numeric block control the borders of a marked range. With these keys 
it is very
easy to move the range borders in small steps to all directions. The steps of the movement 
depend on
the zoom depth!

Cursors on Range Borders
This function sets two cursors called S and E on the borders of a marked range.

Zero Crossing 0 -> Range <- 0
This function in menu "Range" sets the borders of a marked range to the next zero crossings



inside
the range (useful for loop finding). Shortcut: key 5 in numeric block

Get Range Length
By selecting this option with Ctrl + F1...10 you can set the length of one of the defined 
ranges as the
current range length.

External Program 1 and 2
This menu item in menu "Special" runs an external program with the actual project as 
parameter. This
makes it easy to export a Samplitude project to another audio software for special edits.
Use the ?-button to select the external program you want to run.
After editing and saving the file in the external program you can load it back to Samplitude 
using the
recent file list in menu "Project".
This function works only with HDPs in Mono or Stereo Wave format!

Close all audio devices
This menu item in menu Special closes all audio devices to give other audio software a 
chance to use them for playback and recording in multitasking with Samplitude.

Shortcut R for Recording
You can use the r key to open the record window. In the record window the r key starts 
recording, the s key finishes the recording, the o key Closes the record window. So you can 
record complete tracks without the need of button clicking!
The shortcut for snap on/off is now Control + r.

Recording VIPs with default settings
When recording without a VIP, Samplitude creates a new VIP after finishing the recording. 
This VIP
gets its settings from the last    call of the "New VIP" dialog (Units of measurement, Fix 
vertically...).

MSF 75 frame units
You can select the CD type 75 frame per second format as units of measurement in menu 
"Setup >
Units of measurement".

Select 1 View with Shift b
Simply by pressing Shift + b you can switch to 1 view, what is useful when suing the b key to
edit loops
etc. in the 3 views mode!

Wave Import with Ctrl-I
The Wave Import function has the new shortcut Control + I.

Close all Windows with key h
The key h is now the shortcut for the menu Window > Close all Windows.



Menu Project

The project menu contains wide-range functions for generating, managing, loading and saving projects.

New Project 
>Virtual

A new virtual project is opened.

Open Project A new project is loaded, which 
was created by Samplitude.

Save Project The actual project is saved.
Save Project as... The actual project is saved with a 

new name.
Save Complete VIP
to...

The actual VIP with all needed 
files is saved to a new directory.

Rename Project The actual project gets a new 
name.

Delete Project A HD project is deleted from 
harddisk.

Import Sample A Wave file is opened.
Export Sample A Samplitude project is saved as a

Wave file.
Record... The Record window is opened.
MIDI-Sample-
Dump...

Transfers sample data between 
the PC and a MIDI-Sampler.

MIDI/Video-Link... Synchronizes .MID or .AVI files to a
Samplitude project.

Range Manager... The window of the range manager
is opend.

Cursor Manager... The window of the cursor 
manager is opend.

Project 
Information

Shows information about the 
actual project.

Load Session Loads a complete Samplitude 
session.

Save Session Save a complete Samplitude 
session.

Exit Exits Samplitude.



 New Project > virtual (Menu Project)

A new virtual project is opened, you can choose the track number between 1 and 16 Mono tracks or 1 and
8 stereo tracks and select a name for the new VIP.
The number of tracks depends on the version of Samplitude:
Light Version: 2 Mono or 1 Stereo
Multimedia Version: 4 Mono or 2 Stereo
Pro Version: 8 Mono or 4 Stereo
Studio Version: 16 Mono or 8 Stereo
New virtual projects get the following bit shifts to avoid clipping (1 bit less than former 
versions):
1,2,and 4 tracks mono and 1 and 2 tracks stereo: 0 dB
8 tracks mono and 4 tracks stereo: -6 dB (1 Bit)
16 tracks Mono and 8 tracks stereo: -12 dB (2 Bits)
The default volume silder position is -6 dB for each track.
Please know, that this setting has no safe volume reserve, if you increase the volume level 
with the sliders you may produce clipping, if the material has maximum level on all tracks.
You can change the volume settings in the dialog Project > Project Information or with the i 
key!

Mono: This button mixes the output of the VIP to Mono in case of Mono tracks. The left and the right 
output of the sound card carry the same signal.

Units of Measurement: Here you can select default units of measurement for the new VIP.

Settings Grid:
Activates the grid view by default.

Fix vertically:
Disables the feature of vertical range marking.

Snap to objects: 
Activates the object snapping for the new VIP

Lock record objects: 
Locks all recorded objects against moving. 
This is very useful in multi track projects!

Shortcuts:
Toolbar:

Keys: e



Open Project (Menu Project)

Use the Open Project... command to open already existing projects. Samplitude will let you choose 
between RAM, HD and Virtual projects. After specifying which type of project you want to open, you will 
have a chance to load the wanted file. If a project is successfully loaded, the project window will appear 
on the screen.

Shortcuts:
Keys: L for RAM projects
Keys: SHIFT+L for HD projects
Keys: o for virtual projects
Keys: w for wave files



Save Project (Menu Project)

The current project is saved with the name displayed in the project window. If    you previously have not 
specified a name for your project, Samplitude will ask you to do so. 

Shortcuts:

Toolbar:
Keys: s



Save Project as... (Menu Project)

You can define the path and name of the new project you want to save your work under. RAM projects 
and virtual projects will be saved with the new names (the source file remains untouched). HD projects 
are renamed on the hard disk. Samplitude will not generate a copy of it for reasons of conserving space 
on your hard drive.

Shortcuts:
Keys: SHIFT + s



Save complete VIP to... (Menu Project)

This function in menu "Project" allows saving a VIP with all needed projects (HDPs, RAPs) into
a
specified directory. This makes it easy to copy all files of a VIP to a backup disk etc...



Rename Project... (Menu Project)

The Rename Project command will let you rename a project file rather than save it to a different file. For 
RAM projects, only the internal names are changed (without being saved). But all corresponding files are 
renamed immediately in the case of HD projects.



Delete HD Project... (Menu Project)

HD projects are deleted from the hard disk. Use this command with caution as all corresponding files are 
lost.



 Import Sample... (Menu Project)

Samplitude gives you the option of importing wave or dump files into a Samplitude project. You will need 
to specify which type the project is going to be, a RAM Project or a HD Project.



 Export Sample... (Menu Project)

The command Export Sample will let you export project files into wave or dump files. Keep in mind, that 
your project file needs to be either in the 8- or 16-bit mode. You can save it both in Mono or Stereo format.



Record... (Menu Project)

Use this command to record a new wave file. A new Recording Window will be opened and further 
adjustments for the recording can be made. Please refer to the chapter Quickstart for additional 
explanation of the options available.
                            
Record mode Specify the settings desired for your recording. You can switch between Stereo or 

Mono and if you want to record either to your hard disk (HD) or to your computers 
memory (RAM).

Wave Here you can indicate, whether you want to produce the files direct in the Windows 
Wave Files format.

Preload With this option all preparation for the recording is processed ahead and a window will 
appear, with which the recording can be started without any processing delays.

Sample Rate Choose the sample rate needed. Please note that this option is based on your 
soundcards abilities of recording with different sample rates such as 48 kHz. Make 
sure your soundcard supports the option chosen.

Device Please select the desired device you want to use for recording. If you have more than 
one soundcard installed in your system, this window will let you specify which card to 
use. Make sure the soundcard is properly installed in Windows and is operational. If 
you do not see an entry in this window, check whether a device drive has been 
installed for you soundcard.

Path The Path option as well as the File Name option are only available for recording to a 
hard disk file. Once you specify a path (directory) to record to Samplitude will 
remember it for future recording sessions. 

Graphic file Use this option if you want to see a graphical representation of your recorded data 
while you record. It is recommended to use this option with very fast systems only as it
requires an enormous amount of processing power. Turn this feature off for slower 
systems. After you are done recording, the data will be represented in its own window.

Playback while Recording (Samplitude Pro and Studio only) Here the simultaneous recording and 
playback can be activated, if it is supported by the available soundcard(s). If you 
record and playback on different cards you might encounter delays in longer 
passages. These delays are caused by the soundcards and their sample rate 
accuracy tolerance. It is recommended that you use one card only for recording and 
reproduction while you record your project! If your card has a delay between recording
and playback start you can counteract this delay in the field 'Record Offset'. To set this 
value, simply play back a sample with a particular impulse in the beginning and record 
it to the input of that same card. Next, zoom into the VIP, until you can recognize and 
measure the delay exactly. Use the difference between the two samples as the offset 
value in this field.

Virtual Working This mode determines, whether all records should automatically be integrated into a 
virtual project.

Monitor After clicking on the Monitor button, the VU-Meters above will be activated. Make sure 
that your signal is not too strong otherwise the recording will be distorted. Once you 
are recording, the level meters move more slowly, however, it will indicate the 
maximum levels used during the recording. 

Osci A simple oscilloscope view can be opened to display the wave form in a scaleable 
window.

Record Offset Here you can type in an offset in samples, which compensates a delay between the 



record start and the play start of your sound card(s). A typical value is 20-2000 
samples.

Media Samplitude offers you a very powerful feature in linking media files with your recording.
Such media files are typically MIDI or AVI files. If you need to synchronize your 
recording with a MIDI or AVI file, please click on this option. For further details on using
this option, please refer to the menu option Media Link in this chapter. This option is 
only available in the Pro version of Samplitude.

Mark cursor To easily identify positions in your recording you can set cursor points while you 
record. To do this click on the while you are recording your audio signal. As you click 
on the button, the cursor count will increment. Once you return to the projects own 
window, the cursor positions will be visible.

Record Starts recording by activating this button.

Stop To stop the recording please click on this button. In some cases the system can 
become too busy with the processing of the recorded data. If this happens and the 
Stop button will not terminate the recording you can still abort the session by clicking 
on the right mouse button.

OK This will close the recording window and will return to the project windows.

Shortcuts:
Toolbar:

Key: r (second r starts recording)



MIDI-Sample-Dump (Menu Project)

This function (Pro and Studio version only) enables a sample to be transferred to other equipment 
through a MIDI interface. They are often MIDI-Samplers or Keyboards with sample RAM to store the 
sample. If you own a Keyboard which is able to receive samples via MIDI-Sample-Dump, Samplitude 
offers a substitute for expensive sampling equipment. Samplitude can be used as a sample editor for 
cutting, editing and looping samples conveniently through graphical layout. The sample already edited 
can be sent to MIDI equipment and must be specified by a key/keygroup.Samplitude is compatible and 
with all equipment supporting the MIDI-Sample-Dump Standard, e.g. AKAI-Sampler, Roland Sampler, 
Yamaha SY-85/99, Kurzweil K 2000, EMU Emax and others. Please refer to the manual of your 
equipment for compatibility with the MIDI-Sample-Dump Standard.

Physical projects such as RAM or HD projects can be dumped (sent). Before dumping virtual projects, 
you will need to convert them into a physical project (RAM or HD). Use the menu Object and select the 
option Save as HD Project.... 

When receiving a sample with Samplitude, a RAM project will always be created. Please keep in mind 
that the physical limitation of a received sample dump is 2.048.383 samples based on the standards 
limitations. The memory required for a RAM project should be sufficient for most systems.
                      
MIDI-IN Device This button enables you to choose the device through which the PC receives MIDI 

data. Please make sure that the PC and the MIDI equipment can communicate with 
each other by selecting the proper settings for both MIDI-In and MIDI-Out. While the 
transfer occurs an error correction is performed. Handshaking between the devices 
needs to be established for this to work properly.

MIDI-Out Device This button lets you choose the device through which the PC sends MIDI data.

Channel Some MIDI equipment will let you specify a channel for the sample dump. If your 
equipment supports this feature you can specify the MIDI channel with this option.

Sample/Key Some MIDI equipment can be set to receive a sample for a specific key (original 
pitch). Should you have this option available you can specify the key used.

Receive Dump To receive a sample, click on this button. You will need to start the transmission on 
your MIDI equipment after you clicked on the Receive Dump button. Otherwise 
Samplitude will not detect the beginning of the data dumped.

Send Dump Click on this button to start transmitting the sample data to your MIDI equipment. To 
receive the data with your MIDI equipment you will need to start the receiving process 
on your MIDI device before you click on the Send Dump button.

Abort dump If you need to interrupt the transmission, click on this button. The sample dump is 
aborted immediately.



 MIDI/Video Link (Menu Project)

Media Link is one of the most powerful features of Samplitude. With this option you have the opportunity 
to synchronize media files such as MIDI files or AVI files. These can be complete MIDI songs or 
sequences (*.MID files), Video clips (*.AVI files) or other files for which a MCI driver is installed in 
Windows. 

Samplitude is a real multimedia application, not only a program for processing digital audio.

Some of the most common applications include the following:

Synchronizing Samplitude projects with MIDI songs

Since Samplitude offers synchronization to with media files, you can set audio tracks to a already existing 
MIDI song. Certain audio effects in VIPs can be perfectly positioned on MIDI material (e.g. drum loops, 
scratches etc.). Otherwise, a project recording can be synchronized with the MIDI file, so that MIDI and 
audio material will play simultaneously. Please note that the MIDI file is always played through the 
Windows MIDI Mapper. Parameters such as play back device, channel setting and key maps can be 
adjusted in the MIDI Mapper in the Windows system administration.

Synchronizing of Samplitude projects with Video-for-Windows movies

With this capability Samplitude is an excellent tool for film music arrangements. Film and video clips are 
recorded as AVI files. A Samplitude virtual project can then be synchronized with it. The music, original 
sound, voice tracks, effects and much more can be adjusted on the time line and played with the AVI 
video simultaneously. As the final step, the audio signal can be recorded back to the video tapes original 
audio tracks or mixed for broadcasting. 

Since video processing requires an immense amount of system resources, the quality of the image 
displayed is reduced. Please keep in mind that for video/audio processing you will need a computer 
system that is capable of handling the amount of processing. Recommended is a 486/33 or better and a 
fast graphics card.                                                                                                        

File Name Here you can specify the name of the media file with which the current project is 
connected. Please make sure you select the proper file extension for the media file 
(*.MID, *.AVI).

Play always This option will let you specify whether the synchronized media file is supposed to be 
played along with your project. If you need to audition the projects sound by itself, 
uncheck this option to listen to the Samplitude audio alone. The information 
concerning the media link will remain in the background. This way you wont have to 
re-specify the file name and other information again when you are ready to bring 
everything together. 

Load always new Working with MIDI files can be enhanced by this option. By checking the option 
Samplitude will always load the specified MIDI song before audio playback starts. If 
you are running a sequencer in the background and want to alter the MIDI song as 
you work on your audio, simply edit the sequences, save it with the same MIDI file 
name you specified in Samplitude and the changes will be picked up immediately after
starting the audio playback or recording in Samplitude.

This is a very powerful feature to work in conjunction with a MIDI sequencer. However,
system resources are not taken up by trying to synchronize Samplitude with your 
sequencer software. 

Please not that if you are synchronizing Samplitude with a completed MIDI song it is 



recommended to uncheck this option. Samplitude will load the MIDI song only once 
and frees up system resources for the recording or playback of your audio files. This is
especially true for AVI files. The window with the video always remains open. The 
picture contents are controlled by the corresponding cursor position which enables a 
faster playback start.

SMPTE-Offset The SMPTE offset value specifies the shift time of the media file compared with the 
starting time of the project. For example, a value of 30:00 (30 seconds, 0 frames) 
informs Samplitude to start the media file with a delay of 30 seconds.

This can be helpful if you are working on a specific section of a song or video and 
need to add additional audio to the section. You would simply enter the delay in the 
SMPTE-Offset and start recording or playing back the media file at that position.

FX Here a correction factor can be specified. Its function is to optimize the precision of 
positioning Samplitude and media files. 

When the start time of a project is set exactly to the start time of the media file, you 
should not experience any delays or out of sync problems. If you do, it could be an 
indication that the system is overloaded by the amount of processing needed. Both 
reproductions (Samplitude Project and Media File) are handled by extremely precise 
timers. However, a slower system can cause the synchronization to loose that 
precision.

Another cause for delays in synchronized playback could be your soundcards 
inaccuracy in processing the digital audio information with the sampling rate specified. 

FX will let you remedy the problem by multiplying the correction factor with the 
sampling rate. Follow these steps to solve this problem:

1) Make sure that the synchronized playback works properly at the beginning of 
the project.

2) Mark a cursor position just before the end of the project 

3) Change the FX value in small increments (e.g. 1.0001, 0.9999 ...) and start the 
playback from the cursor position. Repeat the adjustment until you get a satisfactory 
result (the playbacks for the media file and the Samplitude project are in sync).

Once you have found an appropriate FX factor, you can use the same factor for other 
projects in the future. 

Video without sound: With this option you can switch off the sound of an AVI video. This is useful, if you 
have only one sound card, because otherwise Samplitude and the AVI audio could 
produce conflicts accessing the same sound card.
If you have two sound cards with Windows drivers you can switch off this option to 
hear both Samplitude and the sound of the AVI file.

Video in Samplitude window: With this option you can set the AVI window as a child of the Samplitude 
window. Thats why the AVI window is always visible and cannot be behind Samplitude.
This mode is the default option.
Note: Depending on your AVI driver it may be, that the video does not start when you 
start audio playback the first time. Simply start playback in Samplitude again and the 
video will run!

Test Plays the specified media file for auditioning purposes.

Unlink Sometimes it is necessary to unlink the media file specified. This option will let you do 
that.





 Range Manager... (Menu Project)

The Range manager is a window illustrating all ranges of the current project. The current range is marked
by a colored bar. The range bounds are marked by clicking on the range name. The range name can be 
changed in the lower line. Ranges can be deleted and new ranges can be saved.



 Cursor Manager... (Menu Project)

The cursor manager is a window showing you all cursors of the current project. The current cursor is 
marked by a colored bar. Clicking on the name of a cursor switches to the marked position in the 
corresponding project. Cursor names can be changed in the lower line Cursors can be deleted. New 
cursors can be saved.



Project Information (Menu Project)

This will show you information on the current project. This includes creation date, memory size, path and 
file names. For virtual projects a list of all included physical files is displayed. 

There is also a setting of the project volume in steps of 6 dB. This volume setting is important for 
multitrack projects since the sum of all digital tracks may not exceed 16 bites (0 dB). Each track of a 4 
track stereo project must be reduced by 2 bit's (12 dB). In the real world application, tracks are often not 
recorded or played back at the maximum level so that the reduction can be adjusted accordingly. 
However, raising the volume reduction setting may result in clipping.
Shortcuts:

Key: i



Load Session (Menu Project)

This option will let you load a previously save session. All windows and displays are arranged in the same
way they were found in at the time you saved a session.



Save Session (Menu Project)

This will let you save a complete session in Samplitude. This includes information about all just opened 
projects and their respective window positions etc.. This is useful to be able to continue later at the same 
place without having to load the individual projects first.
If a session is stored with the name 'startup.sam', this session is automatically loaded at the next start of 
Samplitude.



Exit (Menu Project)

This command will exit Samplitude. Please note that all changes made to any project not saved prior to 
exiting will be lost.

Shortcut: Alt + F4



Object Menu

In Menu Cut most functions also work with virtual projects (VIPs). They are faster, because it 
is not necessary to manipulate physical sample data. The function Mix with Clip is not 
available. While cutting, copying or deleting ranges in VIPs the objects will be cutted at the 
range borders. To manipulate complete objetcs, use the object functions:

New Object A new object is generated.
Select Objects All objects in marked range are

selected.
Switch Selection All objects in marked range 

toggle the selection.
Cut Objects All selected objects are cutted.
Insert Objects The objects in CLIP will be 

inserted at the cursor position.
Delete Objects All selected objects will be 

deleted.
Extract Objects All NOT selected objects will be

deleted.
Duplicate Objects All selected objects will be 

duplicated.
Duplicate Objects 
multiple

All selected objects will be 
duplicated multiple.

Lock Options Selects options for object 
locking.

Lock Objects All selected objects will be 
protected from moving.

Unlock Objects All selected objects will be 
unlocked.

Build Loop Object Generate an object with a loop 
range.

Hotspot The current cursor position is 
made a reference point.

Move Object Moves objects to a specified 
position..

Split Objects All selected objects are 
separated at the cursor 
position.

Group All selected objects build a 
group.

Ungroup All selected objects will be 
ungrouped. 

Object Background 
Color

Sets a background color for 
objects.

Object Foreground 
Color

Sets a foreground color for 
objects.

Object Name Changes the name of objects.
Track Bouncing Converts a VIP to a HDP or 

Wave file.
Object Manager Opens the Object Manager.
Object Editor Opens the Object Editor.
Delete Volume Handle Deletes selected volume 

handles.



New Object (Menu Object)

Use this function to create an a virtual object. The current range in the physical project will be inserted 
into the virtual project at the cursor position. It will also be the currently selected object. This is the same 
procedure as the drag & drop method explained earlier in this chapter.



Select Objects (Menu Object)

To select all objects located partially or entirely in the marked range or at the current cursor position. 



Switch Selection (Menu Object)

To select all objects located partially or entirely in the marked range or at the current cursor position. 



Cut Objects (Menu Object)

The currently selected object is replaced with empty space and copied to the VirtClip. The length of the 
current project remains and all other non-selected objects remain in their positions. The previous contents
of the VirtClip is replaced with the cut object.



Copy Objects (Menu Object)

To place a copy of the currently selected object into the VirtClip select this option. The contents of the 
VirtClip can then be inserted into the project using the Insert Objects option (see below). The previous 
contents of the VirtClip is replaced.



Insert Objects (Menu Object)

Objects in the VirtClip can be inserted in the project at the current cursor position. The other objects in the
project maintain their positions. Please note that portions of the already existing objects might be covered 
by the newly inserted object. Simply drag the new object to a different set of tracks or reposition the object
on the same tracks.



Delete Objects (Menu Object)

The selected objects are deleted from the current project. The length of the current project however 
remains the same. Previously unselected objects keep their positions. The contents of the VirtClip remain 
unchanged.

Shortcuts:
Keys: CTRL + Del



Extract Objects (Menu Object)

All currently unselected objects are deleted. The contents of the VirtClip are not changed. Use this option 
with caution. Make sure you have all objects marked as selected which are to remain in the virtual project.



Duplicate Objects (Menu Object)

All selected objects are duplicated and pasted to the same position as the original objects. The original 
object is overlaid with the copied object. The duplicate object can easily be shifted to a desired position by
using the mouse. If several objects have been selected before the duplication, press the shift key before 
shifting to ensure that all objects remain in selected status and are shifted together.
This option does not make use of the VirtClip, so all contents of the VirtClip remain unchanged.
This function is also available using your mouse. Press and hold the Ctrl-key, click on the object you want 
to duplicate and drag the copy to a new position in the project.



Duplicate Objects multiple (Menu object)
With this function selected objects can be duplicated repeatedly. A dialogue is opened, in which the 
number of copies, the respective distance and the total length can be indicated. Also consider with this 
method the possibility to build loop objects!



 Lock Options (Menu Object)

Here you can select, which options should be disabled:
Moving: Disables moving of objects (default). This is useful in multitrack projects to avoid 
delays between several tracks.
Volume changing: The volume handles are disabled.
Fade In/Fade Out: The fade handles are disabled.
Length changing: The length handles are disabled.



Lock Objects (Menu Object)

To protect objects from unintended shifting use this option. First select the objects you want to lock in 
place and activate the lock function. A diagonal line is placed across the locked object.



Unlock Objects (Menu Object)

Locked objects are unlocked and made available for shifting. Make sure you have selected the object(s) 
you want to unlock prior to activating the unlock function.



Build Loop Object (Menu Object)
With this function a loop can be defined within an object. An area which indicates the loop length must be 
marked in the object first. 
The object then becomes the loop object. That means that the number of loops can simply be 'raised' with
the 'length handlers' at the bottom of the object. 

Such generated loop objects are ideal for generating long drum sequences from only one drum loop! 
Loop objects also help to save memory, since in the VIP only one object is handled rather than multiple 
objects or copies of the same material or very long samples!



Hotspot (Menu Object)

The current cursor position is made a reference point for the raster function applied to a selected object. 
Instead of the objects beginning, the hot spot is now used for shifting by different rasters. 
Hot spots are illustrated by stroked vertical lines. Hot spots may stand outside an object (in front of or 
behind the object). 
This function is very useful for cases where the portion of an object to be synchronized does not line up 
with its beginning.



Split Objects (Menu Object)

You can separate objects when you need to delete or shift only parts of them. All selected objects are 
separated from the cursor position into two individual objects. When a covered object is separated, the 
object just being created will cover the original.

Shortcuts:

Key: t



Group (Menu Object)

All selected objects are grouped together. All operations are applied to the whole group. 

Shortcuts:

Toolbar:



Ungroup (Menu Object)

Selected objects are ungrouped. Individual objects are available for processing after that.

Shortcuts:
Toolbar:



Object Background Color (Menu Object)

Sometimes it is necessary to distinguish certain objects from others. Samplitude will let you specify 
different colors for selected objects. Once you have selected one or more objects, choose Object 
Background Color from the Object menu and specify a different background color for the objects. After 
clicking on OK all selected objects will have the specified background color. 



Object Foreground Color (Menu Object)

The foreground color (such as sample data displayed) can be changed as well. After selecting the desired
color, all selected objects in the project will have the same foreground color.



Object Name (Menu Object)

Another way to distinguish certain objects is to give them a different name. Samplitude will let you specify 
a name (such as Verse) with this option. Please note that the name only shows up if you enabled this 
option in the Object Drawmode definition window (available from the Setup menu or by pressing 
Shift+Tab when the object is selected).



Track Bouncing (Menu Object)

The current virtual project can be converted into a Samplitude HD project or a wave file. Samplitude offers
two ways to perform this function:

1) The complete VIP is converted into a HD project.
2) Only the marked range will be converted.
This function eases the disadvantage of having only a limited number of tracks in the VIP. The tracks 
which have already been arranged will be converted into a HD project and the virtual tracks are freed up 
for other tracks to be added track bouncing).
This function requires large memory in some cases. This depends on the length of the VIP.
The maximum amplitude in dB of the resulting file will be displayed after the conversion takes places.

In four track projects two tracks are mixed respectively on one output channel. To avoid clipping during 
the mixing a reduction of the amplitude by 6 dB is performed (that corresponds to dividing it by two). 
In eight track projects the reduction is set to 12 dB. This reduction can be manually 'turned off' in the 
menu 'Project', 'Project Info' by setting a different value.



Object Manager (Menu Object)
In the object manager all objects used in a VIP are indicated in sequence of their temporal appearance. 
With this option the object manager features a function which is often offered in other programs with 'Play 
Lists'.

In the object manager objects can be selected, which are also activated in the VIP. Small objects can be 
identified and manipulated easily. 
Ctrl + a mouse click will select several objects; Shift + a mouse click will select all objects between two 
marks (like in the Windows File Manager).

Especially productive is the search function in the object manager:

With it you can look for certain objects in full text mode rather than just the graphical representation of the 
objects. An example would be to look for all HD projects with the name 'XYZ.HDP' or all objects that 
contain the name 'Intro'. You simply enter the search criteria in the text field and click on 'Search'. All 
found objects will be selected and are available for further processing.



Object Editor (Menu Object)

The object editor lets you select the curve types of the real time object fades (fade in and 
fade out). So you can
give the fades any curve type from logarithmic to exponential.
Activate the object editor with the menu "Object > Object Editor" or with a right + left 
mouse click on
the object!

Shortcut: right + left mouse button



Delete Volume Handle (Menu Object)
With this function volume points can be deleted which have been previously selected. For individual 
volume points a double click with the right mouse button is sufficient to delete it. However, for several 
selected points (e.g. with Shift + right key or through the lasso function) the 'Delete Volume Handle' 
function is available.



Move Objects (Menu Object)

With this function you can move an object to a specified position. A dialog is opened, where you can 
select the new position in samples, milliseconds or SMPTE time.



Menu Cut

This menu contains all functions which are similar to cutting on a tape machine. Please note for stereo 
projects that these operations are performed on both samples in the project.

Activate cutting and copy also makes a project named Clip activated. The window for this project will 
appear if double-click on the icon.

Cut Cuts the marked range into the 
Clip.

Copy Copies the marked range into the 
Clip.

Copy As Copies the marked range into a 
new file.

Insert Inserts sample data from the Clip 
on the cursor position.

Delete Deletes the marked range.
Extract Range Deletes sample data before and 

after the marked range.
Insert Workspace Inserts memory in the length of 

the range.
Mix with Clip Mix sample data with the Clip.
Overwrite with 
Clip

Overwrites sample data with the 
Clip.

Crossfading Crossfades sample data with the 
Clip.

Auto Crossfade Switches auto crossfade mode on 
or off.

Cut (Menu Cut)

The data of the marked range is removed from the current project and placed onto the Clip (Clipboard). 
Since the range was physically removed from the sample, the contents of the sample are reconstructed 
and the overall length is going to be shorter. In case of a virtual object, the range is removed and two 
objects are left behind containing the remainder of the object data.

Keep in mind, that the Clip contains as many samples (mono or stereo) as have been removed from the 
project. The Clip will contain one sample if you have cut the range out of a mono project, two samples if 
taken from a stereo project. 

Also, the sample resolution is the same as in the project. The former contents of the Clip are deleted.

After the function has completed successfully, the cursor will be positioned at the same location the 
removed range started. If you have accidentally removed a range, simply reinsert the range right after you
have cut it from the project. Since the cursor position denotes the beginning of the range, the cut data will 
be inserted at the same position.

Shortcuts:

Toolbar:
Keys: CTRL + x or x



Copy (Menu Cut)

The current range is copied into the Clip but not deleted in the project. The sample length is not varied. 
Please note that the former Clip contents are deleted. The Clip again has the same attributes as the 
project.

Shortcuts:

Toolbar:
Keys: CTRL + c or c



Copy To (Menu Cut)

The current range is copied into a new file. A file requester appears to select the name of the new project.



Insert (Menu Cut)

To insert the contents of the Clip at the current cursor position, use this command. If a range is selected, 
the contents of the Clip are inserted before the selected range. The remaining sample data is shifted 
toward the end and the sample length is extended by the inserted data.

If the Clip was empty Samplitude will inform you with an error message.

The following table shows how Samplitude responds in the case the clip and the project have different 
channel numbers:

Clip Project Clip Channel Project Channel
Mono Mono Channel 1 Channel 1

Stereo Stereo Channel 1 Channel 1

Channel 2 Channel 2

Mono Stereo Channel 1 Channel 1

Channel 1 Channel 2

Stereo Mono Channel 1 Channel 1

The inserted data is defined as a range for further processing. If you inserted the data by mistake, simply 
delete the range with the Cut command in the Cut menu. 

Shortcuts:

Toolbar:
Keys: CTRL +v or v



Delete (Menu Cut)

The data of the current range is deleted. The sample data after the deleted range is added at the position 
the deleted range started. The sample length becomes shorter.

Please note that this command will not save the deleted data to the Clip. If you want to preserve the 
deleted sample data, use the Cut command. Using this the Delete command will delete the data from the 
current sample and preserve the contents of the Clip.

Shortcuts:
Keys: Del



Extract Range (Menu Cut)

This function is the counter part of the Cut function. The current range is maintained and the unselected 
sample data is removed. 

Please note that this function will not copy the deleted data to the Clip. All deleted data is lost. On the 
contrary, the contents of the Clip are preserved.

Shortcuts:

Toolbar:



Insert Workspace (Menu Cut)

The Insert Workspace option will insert blank data at the current cursor position or the position of the 
currently selected range. Size and position of the inserted blank space will depend on the length of the 
range selected before. 

The blank space will actually contain data with zero value. The data following the insertion point will be 
added to the end of the blank space. The defined range is maintained, the overall sample is extended by 
the length of the inserted space.

If you do not have sufficient memory to insert the workspace (i.e. with RAM projects), Samplitude will 
display an error message.



 Crossfading (Menu Cut)

with RAM or HD projects:

The range in front of the cursor or the marked range is cross-faded with the Clip contents. Follow the 
steps below:

1) Copy a range into the Clip.

2) Set the cursor on the desired position and then call up the crossfading function.

with Virtual Projects (VIP):

Two objects in a VIP track can be comfortably enhanced with a realtime crossfade. To accomplish this the
back object must be selected. Then the crossfade function is called. You can indicate the length of the 
fade in different units or get the range from the current area. 
Make sure that sufficient material is available before and/or behind the object borders to be able to 
produce the desired crossfade length. 

The curve forms of the fades (In/Out) can be freely selected from linear to exponential to logarithmic. If an
area is marked over the crossfade interface it can be monitored with the spacebar while the parameters 
are changed in the editor. A realtime preview is always available this way!

Keep in mind, that long crossfades require twice as much processing power than simple tracks. After all, 
two samples are simultaneously mixed and played in realtime. If needed increase the VIP buffer size in 
the menu 'Setup', System'. Linear crossfade curves conserve more processing power than non-linear 
curves!

Shortcuts:
Toolbar:



Auto Crossfade active (Menu Cut)
With this function a mode is activated, at which all newly recorded or from physical projects into the VIP 
pulled objects receive an automatic crossfade. 

A standardized fade-in is added to each object which can be edited in the crossfade editor with 'Global 
Get/Set'. If two objects are overlapped in this mode the result is a realtime crossfade.

The auto crossfade mode is an excellent tool to easily perform a linear cut of a spoken voice track, jingle 
track etc., which requires a soft passage without the unwelcomed 'pops'. If needed each crossfade can be
edited in the editor or by manually manipulating the handlers.

Shortcuts:
Toolbar



Mix with Clip (Menu Cut)

The range contents and the Clip contents are mixed. Channel assignment between project and Clip 
follows the table above (See Insert function). The contents of the Clip are not altered.

Since either components are combined with their full sample values, make sure that no overmodulation 
takes place. This function is performed by way of addition. This assures on one hand, that the project 
sample remains free of a sudden volume decrease. On the other hand modification of the amplitude might
need to be performed before the mix to keep the resulting sample from clipping and distorting. For 
information on amplitude modification see Editing Menu.



Overwrite with Clip (Menu Cut)

The current range is replaced with the Clip contents. The overall sample length remains unchanged. The 
data that occupied this position before cannot be recalled. The Clip contents are not changed. The 
assignment of the Clip channels follows the table mentioned above.



Menu Edit

This menu will let you physically alter the sample data. Some functions only work for a marked range. If 
you want to edit the whole sample you will need to select the whole sample as a range (see function 
Range All in the Range menu).

Set Zero Sample data values in a marked range
are set to zero .

Invert Sample data values in a marked range
are inverted.

Backward Sample data values in a marked range
are reversed.

Fade in/out... Sample data values in a marked range
are faded in or out.

Normalize... Sample data values in a marked range
are normalized.

Amplitude / 2 The amplitude of the samples is 
halved.

Amplitude * 2 The amplitude of the samples is 
doubled.

Compressor Dynamics functions like 
Compressor, Limiter, Expander, 
Gate.

Remove DC-
OffsetHID_REMOV
E_DC

Removes a DC offset from the 
marked range.

Sampledata / 2 The number of samples is halved.
Sampledata * 2 The number of samples is 

doubled.
Resample... Resampling and Timestretching.
Convolution Convolution function for reverb, 

echo and filter effects.
Echo... An echo effect is calculated.
Reverb... A reverb effect is calculated.
Filter... Highpass, Bandpass, Lowpass
Graphic EQ A graphic 5 band equalizer is opend.
Parametric EQ A parametric 3 band equalizer is 

opened.
Build Loop A smooth loop is calculated.
Undo Undo last operation(s).
Redo Undo last Undo-operation(s).
Undo-
adjustments...

Select Undo options

Set Zero (Menu Edit)
Sample data values in a marked range are set to zero (no data). Noise and imperfections in a sample can
thus be eliminated.



Invert (Menu Edit)
The sample data within the marked range is inverted along the amplitude axis. This phase inversion 
means that negative values become positive and vice versa. This function, too, is reversible.

The Invert function permits samples with different phases to be matched.

Along with the available mixing functions (which are, from a mathematical viewpoint, adding functions) 
you can actually subtract samples by applying this function to the selected sample.



Backward (Menu Edit)
The sample data in the marked range is reversed along the time axis. The playback of the sample data 
happens from the end to the beginning. This allows for very interesting effects, not to mention the hidden 
messages frequently referred to in various songs.

This function is reversible: if you do not mark a new range, calling this function once more leads to the 
original material.



 Fade in/out (Menu Edit)
This function allows sample ranges to be faded in or out. 

The amplitude is varied in its time characteristic from the start value of the beginning to the final value at 
the end of the range. When the function has been called, a window appears in which you can specific 
parameters for this operation.

A simple fade-in operation would be performed with the parameters from 0% to 100%, whereas normal 
fade-out requires the specification from 100% to 0%.

The fade curve can be adjusted from linear to exponential or logarithmic.

Notice that real time fading is applied to virtual projects only (with handles). For all other projects (RAM 
and HD) the sample data is physically altered.

Shortcuts:
Keys: f



 Normalize (Menu Edit)
This function modifies the samples overall amplitude.

The data is altered so that the maximum amplitude occurring in a specified range is set to 100% (or any 
other value between 1-400%). Samplitude will first detect the maximum and relate it to the percentage 
chosen. Then all other values are weighted with the new factor.

The Normalize function is designed to fully modulate or over-modulate samples. A particular application is
processing done before a conversion from a higher sample resolution to a lower resolution takes place. 
Since the dynamic range of the low resolution is smaller, it can still be fully utilized by applying the 
normalize function.

If working with sounds from one single instrument, you should set the factor to 100%.

If, however, your piece of music has for example background percussion, you will be able to over-
modulate the sample to 120% to 200%. This will only cut off the new percussion peaks. The same method
allows you to alter the sound of natural instruments by over-modulating them.

Shortcuts:
Toolbar:

Keys: n



Amplitude / 2 (Menu Edit)
This function divides the amplitude of all sample values by a factor of 2. The same could be achieved by a
fade-in/fade-out with parameters ranging from 50% to 50%. However, this function is much faster since 
computing time is greatly reduced.



Amplitude * 2 (Menu Edit)
The same holds true for the Amplitude * 2 function. However, sample amplitude values are multiplied by a
factor of 2, thus corresponding with a fade-in/fade-out process with parameters ranging from 200% to 
200%.



Compressor / Expander (Menu Edit)
With this editor the dynamics of a sample can be processed. The following functions are available:

Compressor: The dynamics of a piece are limited, loud passages become softer, soft passage become 
louder. Compression is often used, to add a 'punch' to material and to make it more manageable during a 
mix. Normalizing to a value of 100% produces a maximum level. This is desired for digital processing for 
example to CD.

Expander: The dynamics of a piece are increased, loud passages become even louder, soft passage 
become even softer. Dynamic expansion is often used for voice-overs that display a high distortion level. 
Through the expansion the spoke voice is lifted above the level of the noise, which in turn is suppressed. 
Keep in mind, that for an expansion a certain level reserve must exist to avoid clipping!

Limiter: Only the loud passages (above the center level) are limited, soft passages remain unchanged. 
Limiters are used, to reduce the appearance of large level peaks without changing the overall dynamic. 
After the limiter process the overall level can be raised through normalization without having to fear 
clipping or distortion.

Noise Gate: Very soft passages (under the threshold level) are reduced or completely pulled to zero. With
this function the noise between passages can be completely eliminated or reduced to a minimum level. 
This works especially well if high compression ratios are applied (< 0.5) without wanting to amplify noise 
on the tracks.



Remove DC offset (Menu Edit)

This function in menu "Edit" removes a DC offset in the marked range of a physical project 
(RAP or
HDP). Some sound cards produce such a DC offset while recording, so it is useful, if you can 
remove
it!



Sampledata / 2 (Menu Edit)
Every second sampling value is removed and the complete sample is reduced to half its length. The 
audible pitch is doubled, i.e. raised by one octave. When halving the sampling rate you will notice that the 
corresponding upper harmonics are missing.



Sampledata * 2 (Menu Edit)
This function inserts a new value between two neighboring sampling values. It is the average of the two 
sampling values.

The complete sample changes to twice its length and the resulting pitch of the sample is cut in half. You 
must then double the playing rate to achieve the former pitch.

You should note that the higher playing rate does not lead to new upper harmonics.



 Resample (Menu Edit)
Sample data can also be edited by using this menu option (only Samplitude Pro and Studio). Contrary to 
the two functions specified above, the factors for the variation can be specified as desired.

After selecting Resample from the menu the following window will appear on the screen:

Factor The factor refers to both the length and the sample rate. The values can be specified 
from 0.5 to 2.0 to achieve different results. If you want to resample with a larger factor 
than 2.0 or a lower factor than 0.5 use the functions samplerate *2 or samplerate / 2 
first to double or halve the sample rate!

Length new The new length is the length specified in Length old multiplied by the given factor. 
When altering the factor value, the new length and sample rate values are 
automatically adjusted. The resulting new length value can be adjusted manually at 
any time without adjusting the factor value first. If you change the length value, the 
factor value is automatically adjusted. The old length and sample rate values cannot 
be changed. They are predetermined by the current sample.

Samplerate new The same is true with the new sample rate. It can be varied and new values for the 
factor and sample length will result.

Halftone This is not only true for the actual factor value, but also for the number of halftone 
steps that can be specified. The resulting factor would modify the samples in the 
following way:

Maintaining the sample rate would detune the sample by the specified number of 
halftones. Possible values range from -12 to +12, three octaves in each direction. 
Specification in halftones refers only to the factor 1.0, a previous variation is not taken 
into account.

The factor for 'Resampling/Time Stretching' can also be specified in BPM. This will enter tempo values. If 
you have a drum loop which has 160 beats per minute and you want to combine it with a bass loop, which
was recorded with 145 bpm, you the option to specify the new resampling values. Activate the sample 
with the bass loop to perform the time stretching function on it. Next, enter at 'BPM old' the value '145' 
and at 'BPM new' the value '160'. Then activate the time stretch process. The material is now adjusted to 
the new tempo.

Resampling 1 There are 2 modes in this resampling function. The first is Resampling 1 in which the 
original sampling rate is maintained.

Resampling 2 The second is Resampling 2 in which the sampling rate will be matched.

Time Stretching A time stretching function is also available. Drum loops for example can be made 
faster or slower by time stretching without changing the pitch. Otherwise, a sample 
can be tuned higher or lower without changing the time. Time-Stretching 1 will perform
the time stretch with the original sampling rate maintained.

Pitch Shifting The pitch of the sample is changed, maintaining the length.

Range Length The range length value characterizes the sample length which will be inserted or cut 
out during time stretching. The optimal size depends mainly on the sample material. 
This is why Samplitude offers you the option to get the length from the currently 
marked range. A useful value is 1000 samples at a rate of 44.1 kHz.

Time compression (sample length becomes shorter, - n halftones) is often more successful than time 
stretching. In this case, matching two samples will result in cutting the long one, rather than the short one.

When using the Resample option the original sample is maintained in its own window. This way you can 



preview the edited sample before you keep it. The newly created window is named Temp. When 
processing HD-projects you will need to close or rename the Temp window before you again resample the
contents of the original window. Samplitude will attempt to create the Temp window again and will abort 
with an error message if it already exists. Temp is actually a file residing on your hard disk. Samplitude 
cannot create two projects with the same file name.



 Convolution (Menu Edit)
With the convolution function (Samplitude Studio only) a sample can be linked to any acoustical room 
pattern. Numerous room criteria like reverb, delay, filter effects etc. can be processed over any material. 
Some impulse responses were included with the Samplitude Demo CD ROM.

Dependent on the required quality the convolution function requires very long processing times. For first 
experiments it is recommended to specify a scan point value of around '50'. 

Impulse patterns can be produced directly with Samplitude. An impulse sample is played and then 
simultaneously recorded to get a returned image from an effects processor for example (Record while 
Play 'Impuls.VIP' from the demo CD-ROM).

A demo for this function has been included with the CD-ROM.

Signal: 
Here you can specify the project with the impulse pattern. It must have been opened previously in 
Samplitude as a normal project.

Absorption dB: 
You can increase or decrease the volume by the amount specified to influence the level of the effect 
signal. Especially for a small number of scan points an increase in volume is recommended.

Scan Points:
The convolution is using the number of scan points entered in this field to scan the impulse pattern. If the 
entire sample is processed (button 'All'), the exact acoustical room representation from which the impulse 
pattern originates can be reproduced. However, many times a very long processing time might not be 
desirable. You would typically use between 50 and 500 scan points to approximate the acoustic 
representation.

Scanning - linear:
The scan points are distributed in a linear fashion throughout the impulse pattern. All areas are 
represented with equal values during calculation.

Scanning square:
The scan points are distributed in a square fashion throughout the impulse pattern. The beginning is 
represented more heavily than the end.

Original %:
Here a percentage of the original signal to be mixed with the convolution signal can be specified. Various 
effect/original relationships can be achieved with this parameter.

Calculation Recursive:
You have the option to choose between the non-recursive (standard) and the recursive algorithm. 
Mathematically exact is the non-recursive algorithm only. The recursive algorithm will already include 
calculated effect portions. It generates 'denser' or 'fuller' results, especially with a lower number of scan 
points. If with a higher scan point count (>100) the recursive algorithm introduces 'feedbacks' it is 
recommended to use the non-recursive algorithm.



 Echo (Menu Edit)
The function Echo will let you create an echo effect with your current sample. Regardless of marked 
ranges, this function will always be performed on the entire sample. To avoid overmodulation of the 
sample, a certain modulation reserve should still be available. This means that the sample data must not 
yet reach the maximum/minimum. If needed, this can be done by the normalize function (about 70%).

Echo Delay in ms This parameter specifies the delay between the single echoes or the original 
signal and the first echo in milliseconds. Default is 500 ms, half a second. You 
should consider that the delay depends on the sampling rate. A variation of the 
sampling rate after generation of an echo naturally alters the echo delay.

Echo Decay in % This parameter specifies the volume decrease between the single echoes in per
cent. A value close to 100% results in a slower echo delay. Values below 40 % 
lead to rapid decay.



 Reverb (Menu Edit)

Samplitude offers you the option of adding reverb to your sample. To avoid overmodulation, please make 
sure that there is enough headroom for the modulation to be processed. The sample data should not 
reach the maximum/minimum peak at any time. If needed you should use the normalizing function and 
select a value of about 70%.

To gain a satisfactory effect quality you should consider processing 16-bit projects only. Intensive 
calculation quickly exhausts the accuracy 8-bit samples can offer. This then in turn is audible by a high 
noise level. Should your sample be in 8-bit format it is recommended that you first convert it to a 16-bit 
format before attempting to process it with the reverb effect function.

Note: If your soundcard or PC is not equipped with a special DSP chipset you will need to allow for 
relatively long processing time. This is true especially for slower computers.

Reverb Amount in % This parameter specifies the reverb amount added to the original sample. 100%
would result in effect only, 0% in the original signal.

Reverb Room in % Enter the value of the reverb room here. A value of 100% refers to effects like 
Early Reflections. Greater values specify a larger room, and smaller values a 
smaller one.

Early Reflections in ms Samplitude lets you specify the time in milliseconds of the first reflection of the 
original signal. This affects the fictive space of the room. The greater the value 
in this dialog box, the larger the room.



 Filter (Menu Edit)

In Samplitude you can edit the frequency response of a sample through digital filters. Three types of filters
can be activated (active button ).

Highpass Damps the frequency below the specified range. The higher portion will be 
allowed to pass through. The highpass filter can be used, for example, to damp 
disturbing noise in low frequencies like hums.

Bandpass This filter will only let a certain frequency band pass. Other bands are damped. 
The middle frequency and the bandwidth can be adjusted with this bandpass 
filter. It is suited for the frequency response correction and narrow-band sound 
effects as well.

Lowpass The lowpass filter will pass only frequencies below the middle frequency. The 
higher frequencies are damped. This filter can be used to reduce the high end 
of a signal such as noise suppression.

Note: Digital filters are a vast subject. The filters made available in Samplitude are not meant to be 
universal in their application. Some frequency ranges will work quite well, others will fail to alter the 
sample sufficiently. By experimenting with the digital filters you will find interesting settings and effects. 
We have recently joint development efforts with the TU Dresden (Technical University, Institute for 
Technical Acoustics) to develop sophisticated and diverse digital filter algorithms. Once completed they 
will be introduced in Samplitude.



 Graphic Equalizer (Samplitude-Studio only) (Menu Edit)
This dialog contains a 5 band graphic equalizer. The filters can be adjusted on five pre-determined 
frequency ranges, to alter the sound of a sample.

To accomplish this you must mark an area in the current project or with the 'a' key the entire project. On a 
fast computer (486/66 and higher) a realtime preview can be activated with the test button. With the 
preview a specific setting can be easily examined before it is written back to the sample. On a Pentium 
with 90 MHz or higher all five bands can be calculated in realtime and played back simultaneously!

Equalizer:
The frequency ranges can be raised or lowered individually with the five faders. If you set the fader to the 
'0' position the filter is deactivated and will not consume any processing power. 

Volume:
You can adjust the overall volume with this faders if due to the filtration of the individual levels the volume 
is too low.

Test:
This button activates the realtime preview. If the preview cannot be turned off by pressing the 'Test' button
again (due to overload of the computer) press the spacebar to stop the audio playback. Increase the 
realtime buffer size in the menu 'Setup', 'System' if needed!

3D-FFT:
This button activates the three-dimensional frequency display for the sample (Fast Fourier 
Transformation). You can analyze which frequencies occur in the material and how the filtration affects 
them. The current filter parameters are already included!

FFT:
This button activates the two-dimensional frequency display of the first 512 sample values of the current 
area. The current filter parameters are also included here so that a preview of the filter effect is possible!

Filters:
This button activates the display of the original frequency filter settings set in the faders. Please keep in 
mind, that this curve actually represents the exact impulse pattern of the specified filter and not only a 
crude approximation like it is the case with many other systems.

The effects of a particular the equalizer effect can even be increased if it is repeatedly applied to a 
sample. Various frequency manipulations can be therefore performed on the material!

At this point we would like to thank the Institute for Technical Acoustics of the TU Dresden (Technical 
University of Dresden, Germany) for their excellent cooperation!



 Parametric Equalizer (Samplitude-Studio only) ) (Menu Edit)
This dialog contains a 3-band parametric equalizer. You can activate filters on three freely selectable 
frequency ranges to adjust the sound of a sample. You can produce wideband frequency adjustments for 
both high and low pass ranges as well as smallband corrections of specific frequency ranges.

To accomplish this you must mark an area in the current project or with the 'a' key the entire project. On a 
fast computer (486/66 and higher) a realtime preview can be activated with the test button. With the 
preview a specific setting can be easily examined before it is written back to the sample. On a Pentium 
with 90 MHz or higher all five bands can be calculated in realtime and played back simultaneously!

Frequency:
With the frequency faders the middle frequency of the individual filters can be adjusted between 10 Hz 
and 24 kHz. Through the free choice of the frequency several filters can also be set to the same values to
achieve a greater effect.

Width:
Here the width of the individual filter can be adjusted between 10 Hz and 10 kHz.

Decibel:
This fader set the amount the filter is increased or decreased (+/- 20 dB). A fader setting of '0' deactivates 
the filter and thus consumes no additional processing power.

Volume:
You can adjust the overall volume with this faders if due to the filtration of the individual levels the volume 
is too low.

Test:
This button activates the realtime preview. If the preview cannot be turned off by pressing the 'Test' button
again (due to overload of the computer) press the spacebar to stop the audio playback. Increase the 
realtime buffer size in the menu 'Setup', 'System' if needed!

Setup 1-3:
Here you can change between three different filter setups so that you can quickly achieve an acoustic 
comparison between the different settings during the preview function ('Test' button).

3D-FFT:
This button activates the three-dimensional frequency display for the sample (Fast Fourier 
Transformation). You can analyze which frequencies occur in the material and how the filtration affects 
them. The current filter parameters are already included!

FFT:
This button activates the two-dimensional frequency display of the first 512 sample values of the current 
area. The current filter parameters are also included here so that a preview of the filter effect is possible!

Filters:
This button activates the display of the original frequency filter settings set in the faders. Please keep in 
mind, that this curve actually represents the exact impulse pattern of the specified filter and not only a 
crude approximation like it is the case with many other systems.

The effects of a particular the equalizer effect can even be increased if it is repeatedly applied to a 
sample. Various frequency manipulations can be therefore performed on the material!

At this point we would like to thank the Institute for Technical Acoustics of the TU Dresden (Technical 
University of Dresden, Germany) for their excellent cooperation. 



Build Loop (Menu Edit)

This function utilizes a complex algorithm for optimizing loops in physical projects. It is useful when 
samples are to be used for instrumental sounds as well as wave table synthesizer.

Before you can process a sample you need to mark a range in your sample that already defines the rough
edges of the sample loop. Remember that you can shift and vary a range during playback to find the best 
loop position. A comfortable way to look at the loop positions is by activating the split range mode by 
pressing b. The sample will be displayed in 3 sections.

To gain an interruption-free loop the outer limits of the range will be set to zero. By applying a crossfade to
the material at the loop end containing the sample data in front of the loop beginning, Samplitude will 
create a smooth transition between loop end and loop beginning.

When a cursor is set in front of the marked range, the range between the cursor and the beginning of the 
loop will be used for the crossfade. This offers you a feature found in professional hardware samplers. To 
achieve a short crossfade set the cursor close to the loop beginning. To receive a long crossfade position 
the cursor further away from the loop beginning.

Notice that the distance between cursor and beginning of the loop range needs to be smaller than the 
loop range itself to make a crossfade possible.

Shortcuts:
Toolbar:



Undo (Menu Edit)

Samplitude offers you a comfortable way of tracking your changes in virtual projects. Up to 100 changes 
can be kept in memory and traced backwards

That means, a physical processes (such as normalize, reverb, filter etc.) can be reversed (undone).

Range and cursor manipulations can also be undone using the Undo feature.

Thanks to this extremely efficient feature, critical operations can simply be tried and then reversed to 
return to the original status if the results are not satisfactory.

Shortcuts:
Keys: CTRL+z



Redo (Menu Edit)
Redo revokes the latest undo command.

Shortcuts:
Keys: CTRL+a



Undo adjustments (Menu Edit)

Using this menu option, the undo function for physical and virtual projects can be switched on and off. An 
undo on a physical project requires large memory and takes much time. For that reason, it is switched off 
at first.

The depth of undo can also be specified when working with VIPs. A value of 20 means that the last 20 
changes can be undone. This option also requires memory, but usually just a few kBytes to keep track of 
the changes.



Menu Range
Samplitude offers a convenient way of working with ranges. The Range menu will let you use these 
options. 

Range all The range will cover the complete 
sample.

Cursor to 
beginning

Sets the cursor to the beginning of
the project.

Cursor to end Sets the cursor to the end of the 
project.

Range to 
beginning

The beginning of the range will be 
extended toward to the beginning of the
project.

Range Length to Sets the range length to 1...16 beats.
Range to end The end of the range will be extended 

toward the end of the project.
Flip Range left The current range is shifted left. 
Flip Range right The current range is shifted right. 
Split Range Splits current range in 3 views for 

better loop search.
Store Range Stores current on a function key.
Get Range Recall range from function key.
Get Range Length Recall the length of a range from 

function key.
Store Cursor Stores current cursor on a number 

key.
Store Realtime 
Cursor

Stores current cursor on a number 
key while playback.

Get Cursor Recall cursor from a number key.
Set Cursors on 
Range Borders

Sets 2 cursors to start and end of 
the range.

Set Cursors on 
Silence

Sets cursor to silent positions in 
the sample.

Beginning of 
Range -> 0

Shifts the beginning of a range 
right to next zero position.

Beginning of 
Range <- 0

Shifts the beginning of a range left
to next zero position.

End of Range -> 0 Shifts the end of a range right to 
next zero position.

End of Range <- 0 Shifts the end of a range left to 
next zero position.

Snap to Grid Switches the snapping functions 
on and off.

Snap to Definition Chooses the kind of the raster.
Get last Range Recalls the last range.
Range Editor Edit range borders numerically.
Object Lasso Select several objects with a lasso.

Range all (Menu Range)

The range will cover the complete sample. This command comes in handy if you want to apply changes 
to the entire sample with functions that normally only address certain ranges.

Shortcuts:



Toolbar:
Keys: a



Cursor to beginning (Menu Range)

Both the beginning and the end of a range are located at the current cursor position.

Shortcuts:

Toolbar:
Keys: Home



Cursor to end (Menu Range)

The beginning and end of the range are positioned at the end of the sample.

Shortcuts:

Toolbar:
Keys: End



Range to beginning (Menu Range)

The beginning of the range will be extended toward to the beginning of the project.

Shortcuts:
Keys: CTRL + left



Range to end (Menu Range)

The end of the range will be extended toward the end of the project.

Shortcuts:
Keys: CTRL + right



Range length to Beat 1...16 (Menu Range)

Sets the range length to 1...16 beats. Set the tempo in bpm with menu Range > Snap to... (definitions).



Flip Range left (Menu Range)

The current range is shifted left by the length of the range. Its end will be its former beginning. If there is 
not enough room to place the range, the command will not be executed.

Shortcuts:
Keys: CTRL + SHIFT + left



Flip Range right (Menu Range)

The current range is shifted right by the length of the range. Its beginning will be its former end. Keep in 
mind that if there is not enough room to place the range, the command will not be executed.

Shortcuts:
Keys: CTRL + SHIFT +right



Split Range (Menu Range)

This function is in particular useful for working with loops. If not already displaying in Split Range Mode 
the project is first switched to this mode displaying three sections on the screen.

The upper section displays the whole sample. The section located at the bottom left displays the data 
near the beginning of the range. The section at the bottom right displays the data near the end of the 
range.

The boundaries of the range can be exactly positioned in the lower sections, while the upper section will 
display the location of the entire range. You can also define ranges across several sections.

Shortcuts:
Keys: b



Store Range (Menu Range)

Another powerful feature of Samplitude is the option of defining and saving different ranges for future 
retrieval. An unlimited number of ranges can be defined. You can for example specify different loops and 
compare them while you recall their ranges. This feature is the basis for the playlists in virtual projects 
(VIPs).

If you select this menu item, you have to specify a number with which the current range is to be defined.

Shortcuts:
Keys: SHIFT + F1 ... F10

You can define more ranges by using the submenu Other. You will need to specify a name for the range 
selected.

Shortcuts:
Keys: SHIFT + F11



Get Range (Menu Range)

By selecting this option you can choose one of the defined ranges as the current range.

Samplitude even lets you choose a range while playing. The specified range becomes the current one 
and is audible. Using this method you can change between two ranges comparing them with each other.

Shortcuts:
Keys: F1 ... F10



Get Range Length(Menu Range)

By selecting this option you can choose the length of one of the defined ranges as the current range.

Samplitude even lets you choose a range length while playing. The specified range becomes the current 
one and is audible. Using this method you can change between two range length comparing them with 
each other.

Shortcuts:
Keys: Shift + Ctrl + F1 ... F10



Store Cursor (Menu Range)

You can save as many cursor positions as needed. Using this option you can create markers (locator 
points) along the sample for easy retrieval.

Shortcuts:
Keys: SHIFT + 1 ... 0

Using the submenu Other, you can define more cursors with a desired name.

Defined cursors can be seen    above the sample data section of the project window and can be moved 
with the mouse.

Shortcuts:
Keys: SHIFT + [



Store Realtime Cursor (Menu Range)

With this function (Alt + number key) cursors can be stored during playback. A specific position in the 
material can this way be set for later processing.

Shortcuts:
Keys: ALT + 1 ... 0



Get Cursor (Menu Range)

By selecting this menu option you can easily locate cursor points. Simply specify the desired cursor 
location and Samplitude will position the cursor at that location.

You can even select a new cursor location while playing the sample. 

You should keep in mind that, whenever a cursor has been defined, the range between the cursor and the
end of the sample is played.

Shortcuts:
Keys: 1 ... 0



Set Cursors on Range Borders (Menu Range)

This function sets two cursors to the beginning (S) and the end (E) of a marked range.



Set Cursors on Silence (Menu Range)

This function sets cursors on silent regions in the sample.

You can choose the minimal length of the pause, a threshold level, the start number and a prefix for the 
cursor name.

This is very useful to mark the regions of sample CDs etc...



Beginning of Range -> 0 (Menu Range)

This function shifts the beginning of range to the right of the next zero position.

The function can be called from the keyboard by pressing the left Shift + Alt keys and 6 on the numeric 
keypad at the same time. You can also press the PgUp key.

Shortcuts:
Keys: PageUp



Beginning of Range <- 0 (Menu Range)

This function shifts the beginning of the range to the left of the next zero position.

The function can be called from the keyboard by pressing of the left Shift + Alt keys and 4 on the numeric 
keypad. You can also press the PgDn key.

Shortcuts:
Keys: SHIFT + PageUp



End of Range -> 0 (Menu Range)

This function shifts the end of the range to the right of the next zero position (change in polarity). Zero 
position is the next sample value with zero value or the boundary between a positive and a negative 
sample value (or vice versa).

This is particular useful for searching for loop points.

The function can be called from the keyboard by pressing the right Shift + Alt keys and 6 on the numeric 
keypad or the PgDn keys.

Shortcuts:
Keys: PageDown



End of Range <- 0 (Menu Range)

This function shifts the end of the range to the left of the next zero position.

The function can be called from the keyboard by simultaneously pressing the right Shift + Alt keys and 4 
on the numeric keypad or by pressing the Shift + PgDn keys.

Shortcuts:
Keys: SHIFT + PageDown



Snap to Grid (Menu Range)

This function switches the rasters on and off.

When working with virtual objects the Virtual Raster becomes available. Objects can only be shifted to the
beginning, the end or the hot spot of another object. The reference point is usually the beginning of the 
object to be shifted to. A hot spot when defined will be used as a reference point as well.

If several objects have been selected, the shift is performed by lining up the beginning of the last selected
object in the sequence with the reference object or raster point. All selected objects remain their position 
to each other.

This option can be used to easily rearrange objects with their audio patterns and gain sample-exact 
connections.

The following is an explanation of the options in the Raster Definition window which appears by selecting 
Range, Raster and Raster Definition....

Shortcuts:
Toolbar:

Keys: Ctrl + r



 Raster Definition (Menu Range)

Object Activates the object raster.

Range Activates the range raster and enables the use of the current marked range as 
raster base (by clicking on the button Get Range). This option is very useful if 
you have found the perfect location defining a particular music bar in the 
sample. To transfer that range into the raster use the command Get Range.

Fixed Bar Raster Activates a raster which is based on bars and their beats from the beginning of 
the project. You can specify the speed of the measure by entering the BPM 
(Beats Per Measure) value in the dialog box. By clicking on the Bar Options 
button you have more options to specify the parameters for this option such as 
the time signature.

Free Bar Raster Activates a raster which is based is bars. The difference to the Fixed Bar Raster
option is that Samplitude takes the number of beats entered in the dialog box 
and automatically calculates the speed from the length and position of the 
range. If a complete 4/4 measure is marked the number of beats in the measure
would be 4. The length of the range would determine the speed in BPM that is 
needed to play the sample in the marked time frame.

Bar Definitions This dialog lets you specify the bar settings, e.g. Numerator / Denominator, the 
speed in beats per minute and the timer resolution in peaks per quarter note.

Shortcuts:
Keys: SHIFT + r



Get last Range (Menu Range)
This function restores the last range that was marked. It comes in handy when a range was mistakenly 
deleted by a mouse click.



Range Editor (Menu Range)
The beginning, the end and length of a marked range can be numerically changed in different units of 
measurement. This function will let you specify the minute details of a particular range you need to set.

If you change any of the values in the Range Start, Range Length or Range End sections, all other values
will automatically be updated with the exceptions below:

Change values in the Range Start section:
The end will be maintained.

Change values in the Range End section:
The start will be maintained.

Change values in the Range Length section:
The start will be maintained.

    
Please note the format of the Bar dialog box. The format is displayed as Bar:Quarter:Clicks. Thus a 4/4 
bar with 96 clicks could look like this:

014:03:024

The number of quarters per minute (BPM) can be set in the BPM dialog box of the Raster Definition 
window. 



Object Lasso (Menu Range)
With this function a special mode for the object lasso can be activated:    

The lasso function can also be started direct in an object rather than having to start between two objects. 
This is useful if there is no empty room between objects to start the lasso function.



Menu Setup

The Setup menu will let you specify system parameters and configure Samplitude.

System Global parameters for buffers and 
paths.

Synchronization Options for external 
synchronization.

Views Select number of views.
Fix vertically Marks ranges always with full 

hight.
Grid View Select kind of grid.
Grid Switch grid on or off.
Grid Color Select the color of the grid.
Foreground Color Select color for sample drawing.
Background Color Select color behind the samples.
VIP Display 
Preferences

Select and toggle Display 
Preferences in VIPs. 

Font Selection Select font for grid and objects.
VIP_Mouse Mode Switches between different mouse

modi in VIPs.
HDP / RAP_Mouse 
Mode

Switches between different mouse
modi in HDPS and RAPs.



System (Menu Setup)

In the System menu you have options to fine-tune Samplitude. You can specify parameters such as paths
and play and recording buffers. 

A principal rule about buffers: the larger the buffer, the more reliability you gain in playing back audio files 
(especially on slow systems or in full 8-track mode). However, if you increase the buffer size too much, 
the computers processing time becomes longer and delays might be introduced in the overall command 
handling. You will need to find a compromise between these two factors for each individual computer 
system.

Im/Export To enter the default path for wave import and export. Click on the ? button to 
bring up another window to look for a specific directory in case you do not know 
the full path.

HD Projects To adjust the default path for HD projects.

Ram Projects To adjust the default path for RAM projects.

Virtual projects To adjust the default path for virtual projects.

Sessions: The path for sessions is set.

Play/Record Buffer:

Here the buffer sizes for the playback and recording of audio data are determined. Rule of Thumb is: The 
large the buffer the more secure the playback even on slower systems will operate. However, the reaction
time of certain commands will go up. We suggest therefore that you experiment and find a compromise 
between buffer size and overall processing speed. It will depend on the individual system, what 
parameters will work best.

In the lower status bar you can observe how many buffers are used and whether errors occured during 
buffer access. With this display you will quickly find out, whether your system is able to process the 
selected number of tracks with the specified buffer sizes.

The display 'Buf:    2 / 4 Max: 3 Err: 0' would mean, that currently 2 out of 4 buffers are in use, the 
maximum buffers used during playback is 3, with no errors during playback. Bigger buffers usually 
increase the performance of the hard disk and the maximum track number in the continuous operation.

An increase in buffer numbers increases above all the safety of the system in the light of short term 
overloads, as they can emerge for example through single track crossfades or short overlaps of several 
tracks. Please keep in mind, that the buffer size is measured in stereo sample. A buffer size of 8192 
requires therefore 32 kBytes storage. Under no circumstances should the total memory used for the 
buffers be larger than the physical RAM in the computer. Otherwise virtual storage is used, which undoes 
the positive effect of big buffers.

The menu    option 'Help', 'System Information' shows the current system and memory usage of 
Samplitude.

RAM Buffer The value is defaulted to 8192 samples. This ensures a small access time to 
your computers RAM. For speedier reaction time, try a smaller value.

HD Buffer Default value is a 8192 samples buffer size. This will ensure under normal 
circumstances a short access time to HD. Samplitude will make use of this 
buffer for HD operations such as range testing, loops and other functions in 



conjunction with HD projects. For speedier reaction time try smaller values. If 
you encounter dropouts or phase shifting raise the value of this buffer.

VIP Buffer The default value is a 8192 samples buffer size. Samplitude uses this buffer 
when working with VIPs. In VIPs you are interested in error free playback of 
your audio data. For this reason a higher buffer is used since the system has to 
handle more data throughput.

Realtime Buffer: This buffer is used for realtime preview functions of the digital filters and the 
dynamics functions in the Studio version.

Buffer Number This option will let you specify how many buffers you want to use for data 
handling. The values can be set between 2 and 10. More buffers mean more 
security, but also more memory demand.

HD Record Buffer The default value is 8192 samples. The HD Record Buffer parameter is used for
audio recording to your hard disk. It indicates the block size of the data written 
to the disk.

Please note that if you increase the buffer sizes too much Windows will start putting data into its own 
Swapfiles which in turn will slow down Samplitude significantly.

Shortcuts:
Keys: y



 Synchronization (Menu Setup)

Especially productive is the direct synchronization between Samplitude (all versions) and the MIDI 
sequencers 'Evolution-Audio', Q-Trax and 'MIDI Connections', which functions without applying MIDI 
drivers. This is perfect for combined audio and MIDI processing. As soon as both programs have started 
they communicate position, start and stop commands, so that both programs start simultaneously.

It is not important from which program the playback or recording is started. Convenient is the fast 
exchange between the programs with Alt + TAB or (on large screens) the tiling of the application windows.

Samplitude Studio in addition can be synchronized externally to other instruments or programs. For this 
type of synchronization an interface plus a Windows compatible driver needs to be installed. Compatible 
programs are for example Cakewalk, Trax and others. 

Samplitude Studio will slave to SMPTE/MTC/MC and can act as the master for MIDI Clock and MIDI Time
Code. Please note, that the master sync functions work more stabile than the slave mode and need 
less processor power !

To run Samplitude Studio in multitasking with a sequencer a MIDI connection must exist between the 
sequencer and Samplitude.    That can be done through simple connection of a MIDI input to a MIDI 
output with for example a MIDI interface of a soundcard. 

Better is an internal combination of the programs through a Multi MPU driver (available as shareware 
software), which connects the output of one program to the input of another one. Keep in mind that one 
program will need to act as the 'master', while the other takes the position of the 'slave'. Select the modes 
in the programs accordingly. Starting and stopping is done from within the 'master'. If possible Samplitude
should be the master!

If Samplitude Studio needs to be synchronized to a tape machine, such as a video recorder or a 
multitrack recorder, a SMPTE interface with Windows driver is necessary.

Internally the computer interfaces process the SMPTE code as MIDI Time Code (MTC). You can also use 
an external SMPTE to MTC converter and feed the MTC signal to a MIDI input port on a MIDI interface in 
the computer.

Samplitude supports now real chase lock sync (MIDI Clock and MIDI Time Code/SMPTE).
This means, that the internal sample rate of Samplitudes playback or recording is variied in small
steps, so that Samplitude can follow little timing changes of the sync master.
This is very useful when using sync between a tape or video recorder (master) and Samplitude (slave),
because most tape machines always produce small pitch changes, which results in delays between
the tape and Samplitude, when not using chase lock sync. If the timing changes are too big,
Samplitude produces heavy pitch changes, which may be reduced by entering smaller values for the
Sync Velocity in the sync dialog. Try values of 200 or more, when you need fast pitch changes in sync
mode! In the lower right status bar you can read the actual/maximal pitch change in cents ( 1 cent =
1/100 halftone).
Please know, that the chase lock sync performes a real time resampling, which needs a certain
processing power, so be carefully on slow machines!
When receiving SMPTE/MTC you can start and stop playback with the space key - Samplitude will
always be in sync!

MIDI Clock Input Device:
Here the driver must be selected from which Samplitude will receive MIDI Clocks for the synchronization.
BPM:
Here the tempo must be entered, with which the MIDI Clocks should be received.

MIDI Clock Output Device:



Select the driver through which Samplitude will send MIDI Clocks to the synchronized equipment.
BPM:
Here the tempo must be entered, with which the MIDI Clocks should be sent.

SMPTE / MTC Input Device:
Select the device driver through which Samplitude will receive the SMPTE/MTC signal.

MTC Output Device:
Select the device driver through which Samplitude will send the MIDI Time Code master signal.

Type:
Select the proper frame rate. For example 24 frames for cinematic synchronization, 25 frames for PAL 
video and audio synchronization, 30 frames for NTSC video.

Preroll-Frames:
You can specify, how many frames Samplitude is to ignore before the synchronization starts. Here you 
can account for the fact, that certain analog instruments need time to reach the correct speed. In order to 
have Samplitude link up to the proper time values, a certain preroll frame count can be specified.

Sync Velocity
You can specify how fast Samplitude follows a pitch change of the sync master. A value of 100 is good for
normal purposes. If you need faster pitch changes, try 200 or 300. If you need to reduce the pitch 
changes in Samplitude try 50 or 30!

SMPTE-Offset:
The SMPTE offset is indicated in milliseconds and in SMPTE frames. The offset is removed from the 
incoming SMPTE time code signal to line up differences between tape material and recorded samples in 
Samplitude. With an offset of '60:00:00' milliseconds (1 hour) a tape that was previously stripped can be 
synchronized, if the start point for the recording/playback starts at 1 hour. Samplitude will, however, start 
at the correct beginning position.

Direct Synchronization:
Here you can switch on and off the automatic direct synchronization between Samplitude 
and the MIDI sequencers Evolution-Audio, Evolution Audio-Pro, MIDI-Connections and Q-Trax.
This makes simultaneous work on digital audio and MIDI very easy!
If you have synchronization problems between Samplitude and the MIDI sequencer, please 
read the chapter problems and solutions !
FX:
With this parameter possible inaccuracies during the positioning of long samples can be equalized. 
Requirement is a flawless synchronization at the sample beginning. Follow the instructions in the chapter 
'Problem Solutions'.

Shortcut:    key g



Views (Menu Setup)

Samplitude allows the optional display of one, two or three sections of the samples belonging to one 
project. Other sample programs usually show only one window of a sample.

If you select 2, Samplitude will display the same sample in two window sections. Each section can be 
handled separately. It is possible, for example, to represent the complete sample in one section and a 
zoomed in version of a certain range in the other.

The mode 3 sections is especially useful for searching for loop points.

The whole sample can be shown in the upper section, while the section on the lower left displays the 
beginning of the loop range and the section on the lower right the end of the range. Use the split range 
function for this purpose (key b).

Go back to 1 view with Shift b!

This is only an example of the mode 3 view. All sections can be handled independently. 

You can also drag ranges over the section bounds. Establish the starting point of a range by clicking, then
keep the mouse button pressed and change over to another section. Samplitude will show you the size of 
the range and at the desired location release the left mouse button to determine the end of this range.



Fix vertically (Menu Setup)

Ranges can be dragged (pulled) in Samplitude horizontally and vertically as well. If this option seems too 
strange to you, you can fix the upper edge of a range(s) to the maximum value and the lower end to the 
minimum value. Thus you get the usual representation in range dragging. However, a trade-off is, that you
will not be able to define the vertical extension of a section by choosing the vertical range button.



Grid View (Menu Setup)

With this option you can define the type of grid that is used for the Grid View. Select between several line 
styles.



Grid (Menu Setup)

This menu function will display the grid on the project window. The units of measurement defined in Units 
of Measurement will appear in the upper sections of the grid.

Shortcuts:
Keys: #



Grid Color... (Menu Setup)

Samplitude lets you specify a color for the grid display. After selecting this option, the program will present
you with a window in which you can choose the desired color for the grid.



Units of Measurement (Menu Setup)

Units of Measurement is used to specify the grid dimensions. Several display options are available which 
will appear at the upper section of the grid.

The units supplied with Samplitude are Samples, Milliseconds, three SMPTE Frame options, the MSF 
format for red book CDs (SMPTE with 75 frames) and Bars for bpm display.

Note: If you want to find out what the current speed of the a selected quarter bar is, simply select the 
Beats option. The upper indicator L: will display the BPM. 



Foreground Color (Menu Setup)

Samplitude lets you specify the foreground color for physical samples. Use this menu option if you want to
change the default color to another one.



Background Color (Menu Setup)

You can also specify the background color for physical samples.



VIP Display Preferences (Menu Setup)

The Display Preferences were designed to help you define the two alternative display modes possible in 
Samplitude when working with virtual projects. 

Usually you choose mode 1 for detailed drawing of samples with all information displayed and mode 2 for 
a quick drawing without graphics. Switching between the two modes is possible by pressing the Tab-key.

The menu option will provide you with another window in which you can specify the details of the two 
different display modes.

Peak Meters
Each track in a VIP can have its own exact LED level meter.
The level meters work both while recording and playback and store the maximum level 
(peak hold
function).
Important: Because drawing of    all the LEDs in a multi track VIP needs some processing 
time, switch
them off, when your machine is too slow!
Change Mouse Cursor
This option lets the mouse cursor change to arrows, if you use the object mode in VIPs. It 
changes to a pencil if you activate the draw mode for volume curves.

New Object Mode
This option changes the way Samplitude handles objects in a VIP: In the new mode the first 
right click only activates objects without the "danger" ov moving them. The next click can be
used for move or drag objects or their handles!



Font Selection (Menu Setup)

Samplitude will also let you specify the font used for text display in the various objects.



VIP Mouse Mode (Menu Setup)

Samplitude uses as a preset the left and right mouse button for the functions in virtual projects. The 
documentation exclusively describes this mode.

It is however possible, to execute all functions (like with other programs) with the left mouse button only. If
you click on the right mouse button, a popup menu will appear in which you can select, which function the
left mouse button is to execute.

In virtual projects (VIP) exist these modes:
Right Mouse Button:
Activates the standard mode in which objects are move with the right mouse button.

Ranges Mode:
The left mouse button is used to mark regions and cursors.    

Objects Mode:
The left mouse button is used for object manipulation.    

Volume Mode:
The left mouse button is used for the manipulation of the volume curves (Volume Rubberbands).

Volume/Objects:
The left mouse button is used for the manipulation of the volume curves and the objects (Volume 
Rubberbands).

Volume Drawing:
The left mouse button is used for freehand drawing of the volume curves. This mode is excellent for
creating your own fade curves etc. !



HDP / RAP Mouse Mode (Menu Setup)

In physical projects (HDP, RAP) exist these modes:
Ranges Mode:
The left mouse button is used to mark regions and cursors (default).    

Draw Wave
In this mode you can use freehand drawing to manipulate the waveform. This is useful to correct 
single samples, small distortion peaks, clicks etc... Please use a zoom level of 1:1 or larger for 
exact handling!

Draw Volume
In this mode you can draw the volume of the sample, e.g. to create a special fade curve.
The middle of the display is volume 100%, the lower border is volume 0 and the upper corner is 
volume 200%.



Menu Special

This menu gives you access to special functions dealing with manipulation of projects.

Split Project Splits Stereo projects into two 
Mono projects.

Link Projects Links two Mono projects to a 
Stereo project.

Append Projects Appends one project to another.
Change Resolution Changes the bit resolution of a 

physical project.
Save in Format Save project in another format.
Mono Mixes a Stereo project into a Mono

project.
Stereo Doubles a Mono project into a 

Stereo project.
Graphic Refresh Calculates new graphic data of a 

project.
Play once Plays marked range (or from 

cursor) once.
Play loop Plays marked range (or from 

cursor) looped.
Play in Range Plays from beginning of the 

project into a marked range and 
loops it.

Play with Preload Preload buffers for fast play start.
Stop Stops playback.
Forward/Backward Playback Forward/Backward.
Restart-Play Restart playback from the 

beginning.
Text Comments Edit text comments for the actual 

project.
Multiple Sound 
Cards

Select several sound cards for 
playback.

Remove unused 
Samples

Delete all unused ranges in 
physical projects.

External 
Program1,2

Runs an external program with 
actual project file..

Release all audio 
devices

Closes all audio devices.



Split Project (Menu Special)

Sometimes it is necessary to split a stereo project into two independent mono projects and a quadro 
project into two stereo projects. With this menu option you can terminate the static connection between 
the projects.

If you would like to join the projects again, simply select Link Projects from the Special menu (see below).



Link Projects (Menu Special)

Projects can be linked (or joined) by selecting this option from the Special menu. Two mono projects are 
linked to one stereo project and likewise two stereo projects to one quadro project. This is a convenient 
way of editing joined samples with the same operations.

Make sure that the windows of the two project to be linked are open. Select one of the objects as the 
current object (click on it with the right mouse button) and call up the Link Projects menu option. Next, 
click on the project you want to join. Samplitude will link the two projects.

Note: Linking projects is restricted to joining projects with the same format. In other words, you can only 
link a mono project with another mono project. Likewise, a stereo project can only be linked with another 
stereo project.

Samplitude will automatically match the sample resolution of the two projects as well as their sample 
lengths.



Append Projects (Menu Special)

With this function a project can be appended with another project, i.e. the material of one project is copied
directly behind the material of the first.

You need to first select the object you want to append. Then you activate the menu and click on the 
project you want to add to the first.

A particular use of this option is the 'cleaning up' of VIP's that contain numerous physical samples.



Change Resolution (Menu Special)

In Samplitude you can change the sample resolution of a HD project. The program will create a new 
window with a copy of the sample (range) in the desired format. This way you can easily preview the 
change before further editing takes place. The original remains unchanged.

Possible sample resolution range from 1 bit to 16 bit. Select the desired radio button and its resolution. To
start the conversion click on the OK button. The Cancel button will return you to the previous screen.

Resolutions between 1 and 8 bits occupy 1 byte per sampling value, resolutions between 9 and 16 bits 
occupy two bytes each.

If you like to manipulate an 8-bit sound in different ways, you should convert it to 16 bits in the before you 
start. Computing inaccuracies of altering digital samples will be reduced when done in the 16-bit format. 
After you are done manipulating the sample in 16-bit format, you can convert it back to a 8-bit sample.

Try experimenting with different sample resolutions such as 4 or 5 bits. Interesting effects can be created 
and it is surprising to still be able to recognize the sample somewhat in a 1-bit format.



Save in Format (Menu Special)

With this function you have the possibility to convert projects between the different Samplitude formats. 
That is useful, if e.g. RAM projects need to be converted into HD projects or stereo Wave files into two 
individual mono files.



Mono (Menu Special)

The current project is converted into a mono mode. If it was a stereo project before, both channels will be 
mixed. The previous samples are first added with 100% of their image and then divided by two to prevent 
overmodulation (distortion). This is an equivalent of reducing the volume by 6 dB.



Stereo (Menu Special)

The original mono project is duplicated and converted into a single stereo project with the same sample in
both channels. 



Graphic Refresh (Menu Special)

Display inaccuracies after a complicated sample processing can be cleared by using this menu option. 
The screen (window) will be cleared and redrawn to display the project properly.



Horizontally (Menu Special)

This menu contains all the functions of the horizontal (red) position bar.



Vertically (Menu Special)

This menu contains all the functions of the vertical (blue) position bar. 



Play once (Menu Special)

The project or the range is played once.

Shortcuts:
Toolbar:

Keys: Space



Play loop (Menu Special)

The project or the range is played in a loop.

Shortcuts:
Toolbar:

Keys: Space



Play in Range (Menu Special)

If you have specified a range selecting this menu option (or button) will start the playback of the sample 
from the beginning, enter the range and continue to loop through the range until you press the stop key 
(button). This mode is very useful when testing loops for instrument samples.

Shortcuts:
Toolbar:

Keys: Space



Stop (Menu Special)

The playback is stopped for all projects types.

Shortcuts:
Toolbar:

Keys: Space



Play with Preload (Menu Special)

All buffers are loaded and the playback is ready to be started. Another window will appear with which 
playback can be started at your convenience. No delays will occur. This function is useful on slower 
systems and if    a synchronization must be started in manual mode and an exact start has to be 
performed.

Shortcut
key: Shift + Space



Forward/Backward(Menu Special)

The playback direction can be changed even during the actual playback.



Restart Play (Menu Special)

Playback will start at the beginning even during the actual playback.
Shortcut    is the Backspace key.



Text Comments (Menu Special)

You can enter text comments to the current project via a simple text editor. This text can be displayed at 
each new opening of the project. This will preserve important information about the project together with 
the audio material.



Multiple Sound Cards (Samplitude Studio only) (Menu Special)

This dialog lets you select multiple sound cards for playback of your multitrack projects. Samplitude 
supports up to 4 sound cards for simultaneous playback. This offers you up to 8 genuine individual 
outputs. 

Recording of your material always works only with one soundcard, therefore only in single stereo mode. 

VIPs are always distributed symmetrically to the cards. That means, that for example an 8 track VIP is 
distributed to two soundcards so that the first 4 tracks are played through one card and the second set of 
4 tracks on the next. If you use four soundcards, two tracks are played through one soundcard 
respectively.

Please note:
Playback through several sound cards puts high demands on the accuracy of the sample rate of each 
card! If these do not agree exactly, positioning inaccuracies with longer samples will occur. To 
compensate for these problems you should playback the contents of a track through the same card that 
you recorded them with.



Remove unused Samples (Samplitude Pro and Studio only) (Menu Special)

With this function all projects belonging to the active VIP can be edited in a way that all samples not used 
in the VIP are deleted. The objects in the VIP are thereby automatically adjusted. The VIP itself will not 
change. This function can save much memory.

However, after performing this function length corrections of the objects are only possible on a limited 
scale.



External Program 1, 2 (Studio only) (Menu Special)

This menu item in menu "Special" runs an external program with the actual project as 
parameter. This
makes it easy to export a Samplitude project to another audio software for special edits.
Use the ?-button to select the external program you want to run.
After editing and saving the file in the external program you can load it back to Samplitude 
using the
recent file list in menu "Project".
This function works only with HDPs in Mono or Stereo Wave format!



Close audio devices (Menu Special)

This menu item in menu Special closes all audio devices to give other audio software a 
chance to use them for playback and recording in multitasking with Samplitude.



Menu Window

This menu contains functions for window manipulation.

Cascade Arranges all open windows.
Tile Arranges all open windows.
Untile Restores previous arrangement.
Arrange Icons Arranges all icons.
Toolbar Shows or hides the upper toolbar.
Statusbar Shows or hides the status bar.
Positionbar Shows or hides the position bar.
Transport Control Shows or hides the transport 

control window.
Time Display Shows or hides the time display 

window.
Play Parameter Select sample rate and output 

device for playback, control 
scrubbing and varipitch.

Close All Windows Closes all open windows..
Physical Projects 
to Icons

Changes all physical projects to 
icons, VIPs stay in full size..

Half Height Changes the Samplitude screen to
half the height.

Window 1, 2, ... Activates the window 1,2...

Cascade (Menu Window)

This function arranges all open windows in a cascade style.



Tile (Menu Window)

All open windows are moved next to each other, making use of the whole display area. This is useful 
when dragging physical sample ranges into VIPs.

Shortcuts:
Keys: Return/Enter



Tile (Menu Window)

All open windows are moved next to each other, making use of the whole display area. This is useful 
when dragging physical sample ranges into VIPs.

Shortcuts:
Keys: Return/Enter



Untile (Menu Window)

This function will return the window order to the previous state.
Shortcut is Shift + Return.



Arrange Icons (Menu Window)

All icons are rearranged along the lower portion of the screen.



Toolbar (Menu Window)

Shows or hides the upper tool bar.



Statusbar (Menu Window)

Shows or hides the status bar on the lower portion of the display.



Positionbar (Menu Window)

Shows or hides the positioning bar on the lower portion of the display.



Transport Control (Menu Window)

Shows or hides the transport control window.
This window lets you quickly activate the play, stop, record and scroll functions.
There is a difference between these buttons and the use of the space bar ot the upper toolbar:
If you stop playback, the cursor stays on the last playback position. Next play start continues playback 
from this position.
The fast forward and backward scrolling functions also work while playing!
 
You can zoom the window to any size and position it anywhere on the screen!.



Time Display (Menu Window)

Shows or hides the time display window.
This window always shows the actual time position in the actual format.You can change this format with 
the menu Units of Measurement. We recommend the SMPTE format: hours:minutes:seconds:frames.
You can change the colors and the font name in the Setup menu.
You can zoom the window to any size and position it anywhere on the screen!.



Play Parameter (Menu Window)

The Play Parameter window which appears after selecting this menu option is designed to quickly enter 
playback parameters. Below is an explanation of the options available in this window.

                                                                                                    
Sample Rate The sample rate can be changed here as long as the soundcard supports the 

new rate (some soundcards even support changing the rate while playing the 
sample!). This is especially useful to hear notes in a sample range played in a 
different octave. When selecting half the sample rate the pitch should be the 
same. It would be played one octave lower.

Device To specify the driver of the sound card use this dialog box. Its necessary if you 
have several soundcards installed in your computer.

Autoscroll The Autoscroll section will let you activate the autoscroll feature. It is especially 
useful when working with long disk files. The project window will follow the 
cursor during playback. 
When working in 2 or 3 section display mode, the autoscroll feature will cause 
the individual sections to follow the cursor as well. If you have zoomed into one 
of the sections, the cursor will move through the section faster resulting in more 
screen redraws.

There are two alternatives in auto scrolling. 

The Soft option performs a smooth scrolling of the whole waveform, the cursor 
stays in the centre of the display. This mode needs a fast graphics board, 
because the complete screen is scrolled between the cursor steps.

The Page option performs a page by page scrolling.
Please note, that the auto scrolling requires certain processing power based on 
your processor, graphic card and the resolution of the display. For this reason 
you might encounter small interruptions in playing the audio files. Should this 
occur simply disable the auto scroll feature or raise the buffer size (select Setup 
menu and click on System).

Scrubbing
While pressing the Insert key and moving the mouse you can perform scrubbing. Samplitude
starts
playback at a very low speed, the mouse position relative to the start cursor controls the 
speed.
There are two scrubbing modes (in playback parameter window - key p):
Relative: The distance between the playback cursor and the mouse sets the playback 
speed.
Absolute: The position of the mouse in the window sets the playback speed - at the left 
border
playback speed is 200% backward, at the right border speed is 200 % forward, in the middle
of the
window the speed is 0.
There is a real time resampling performed for changing the playback rate without changing 
the sample
rate of the sound card. For best performance use small play buffer sizes and a fast processor
(Pentium recommended) !

Varipitch
Samplitude supports smooth changes of the pitch while playback, even in multi track 
projects (vertical



slider in playback parameter window - key p).
Activate the Varispeed mode with the "active" button, then you can change the playback 
speed in
various kinds:
Vertical slider - Changes the playback speed from -200% to +200%
Pitch Factor - Lets you specify a certain pitch factor manually
Halftones    - Lets you specify a value of halftones. The playback will be transposed the 
number of
halftones.
Internal Rate - Here you can set a sample rate for the varipitch calculation. If you want to 
play a wave
file with a sample rate of 48 KHz but your sound card can only play rates up to 44.1 KHz 
simply set the
internal rate to 48 and activate varispeed. You listen the same result as playing with real 48 
KHz!
This function is also very useful for digital playback to DAT with 44.1 KHz samples and and 
vice versa!
BPM - Here you can type in the original bpm value of your material and a destination bpm 
value, which
is reached using the varipitch.
Important: Varipitch works also while recording! So you can set the pitch to -2 halftones, 
sing a song
into the computer, then switch off the varipitch - your track is transposed two halftones 
higher!
There is a real time resampling performed for changing the playback rate without changing 
the sample
rate of the sound card. For best performance use small play buffer sizes and a fast processor
(Pentium recommended) !

Shortcuts:
Keys: p



Close all Windows (Menu Window)

Closes all opened projects. Before closing a window/project, Samplitude will ask you whether you would 
like to save the project.



Physical Projects to Icons (Menu Window)

This will reduce all physical projects to their icons to make room for the display of the virtual projects.



Half Height (Menu Window)

The Samplitude screen is shown in the upper half of the display.
This is useful, when using a sequencer program in multitasking. So you can switch between Samplitude 
and the sequencer without the need of complete screen redraws.
When using the sequencer Evolution or MIDI-Conneftions in direct synchronization, their display reduces 
automatically to the lower half of the screen.



1, 2, ... (Menu Window)

Choose active window from the list.



Menu Help

This menu contains the context sensitive online help functions of Samplitude, the title screen with the 
SEKD Logo, CompuServe e-Mail ID and a 3D Sample.

Contents of Help... Shows the items, for which help is
available.

Using Help... How to use the online help 
system.

Context Help Activates the context sensitive 
help system.

About 
Samplitude...

Shows copyright notice and the 
version of Samplitude.

System 
Information

Shows informations about 
memory usage etc...



Contents of Help... (Menu Help)

Use this command to show the contents of the help system. Click the command, for which 
help is needed!



Using Help... (Menu Help)

Use this command for getting informations about the online help system.



About Samplitude... (Menu Help)

Copyright notices and version numbers are displayed.



Context Help (Menu Help)

Use this command, to get help about any part of Samplitude. Click the

button in the upper toolbar and then click on any button or menu item to get the help 
information.



System Information (Menu Help)

A window is displayed, containing information about the memory status and other parameters.

Particularly useful is the display of the free storage on all connected disk drives, the used system 
resources utilized by Samplitude and the memory usage. Make sure the parameter for system memory 
used by Samplitude never grows larger than the displayed overall system memory available (physical 
RAM). If this happens, the performance of Samplitude is reduced caused by page swapping done to 
compensate for the missing memory.



Dialogbox for file selection

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document.    A filename can contain up to eight characters
and an extension of up to three characters.    Samplitude adds the extension you specify 
in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

<< Add other File Save As dialog box options depending on which ones your application 
chooses via the OFN_ flags of the OPENFILENAME structure used by the CFileDialog. >>





File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    Samplitude adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

<< Add other File Save As dialog box options depending on which ones your application 
chooses via the OFN_ flags of the OPENFILENAME structure used by the CFileDialog. >>



1, 2, 3, 4 (Menu Project)

Use the numbers and file names to open one of the last 4 projects.



Undo/Can't Undo command (Edit menu)

<< Your application's user interface for Undo may differ from the one described below.    
Modify this help text accordingly. >>

Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.    The Undo command changes to
Can't Undo on the menu if you cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

<< Write application-specific help here. >>



Upper Toolbar

Bild Aktion

Save Project

Cut Range
Copy Range
Insert Range
About Samplitude...

New virtual Project 
Raster on/off
Auto Crossfade Mode
Group objects
Ungroup objetcs

Cursor to beginning
Range all
Cursor to end

Normalize Range
Extract Range
Build Loop
Crossfade

Stop Playback
Play once
Play loop
Play in Range
Record
Contextsensitive Help



Status Bar

The statusbar is displayed in the lower line of the Samplitude screen. A black bar shows the 
progress in most edit functions.



Title Bar

The titlebar is displayed in the upper line of a windows. It contaisn informations about the 
project title and its length in samples and in bytes.



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave 
in your application. >>



Change size (System-Menu)



Move (Control-Menu)



Symbol (Control-Menu)



Full Screen (System-Menu)



Next Window (Control-Menu)



Previous Window (Control-Menu)



Quit (Control-Menu)



Restore (Control-Menu)



Change zu... (Control-Menu)



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

<< Write application-specific help here. >>



Choose Color dialog box

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Edit Projects

Use the lower button bar for positioning in the project and for zooming.
Use the upper toolbar and the menus for edit operations.
Mark a range and set cursors with the left mousebutton.
Move objects in a virtual project with the right mousebutton.
Start playback with the SPACE key.
Edit the sampleparameters with the P key.

Here the function of the buttons in the tracks of virtual projects (VIPs):
? - This will open the track information dialog. You can enter a name as well as setting realtime functions.
= - Joins two mono tracks. Volume operations will affect both tracks.
M - Mute. This will mute the selected track.
S - Solo. Only this track is played.
L - Lock. Prevents cutting with the menu 'Cut' for this track.
V - Volume. Activates the volume curve for this track.
R - Record. Enables this track to the recording.
Besides the buttons above there is also a volume slider situated in the left section, one for each track and 
(for stereo tracks) a panning slider.

The 8 lower left buttons in a VIP store 4 setups (S1...S4 incl. zoom level, cursor position and display 
mode) and 4 zoom levels (Z1...Z4). So you can quickly switch f.e. between a full size display, a 10 
seconds zoom range and a sample exact zooom level for perfect editing!

LED level meters
Each track in a VIP can have its own exact LED level meter. Switch this function on or off 
with the menu
"Setup > VIP Display Preferences" or with the Shift + Tab key.
The level meters work both while recording and playback and store the maximum level 
(peak hold
function).
Important: Because drawing of    all the LEDs in a multi track VIP needs some processing 
time, switch
them off, when your machine is too slow!
Zoom In/Out by dragging the scroller
There is a new way of zooming in and out: Simply drag the left or right border of the 
scrollbar button
with the mouse. If the "change mouse" mode is activated in Shift-Tab dialog, the mouse 
pointer
becomes an left-right-arrow, if you are above the position for the zoom function!
Move all objects and volume points behind actual position (key m)
While pressing the m-key you can move all objects and volume rubber points behind the 
actual cursor
position with the right mousebutton. This makes it easy to create free space in a VIP or re-
arrange
large projects without the need of grouping objects!



No Help available

For this object is no help available.



No Help available

For this window is no help available.



Quickstart
In this chapter you are guided through the most important functions of Samplitude without completely 
explaining all th details. The emphasis lies on grasping of essential working techniques. After reading or 
practical test of the examples the Quickstart chapter should enable you to learn all remaining details 
contained in the rest of the manual.

Your First Recording Session

If you installed Samplitude and a sound card along with the Windows driver, follow the next few steps to 
gain first results. Let's assume that you have a tape recorder or another audio source (e.g. CD Player, 
Tuner, Microphone etc.), which needs to be connected to the proper input on your soundcard. Start 
Samplitude by double clicking on the Samplitude icon on the program manager. This will bring up the info 
page with the SEK'D logo, which can be closed through any keystroke.

Samplitude automatically opens a virtual project and puts the recording window on top of it.

For a first test we recommend these settings:
RAM - it is recorded in the available RAM
16-bit - it is recorded with CD quality
Stereo - record in stereo
Samplerate - you choose a sample rate, e.g. 22 kHz; this is a good compromise between quality and 
memory requirements. In the device window select the driver of your soundcard, if it does not appear 
automatically. This is especially important for owners of several soundcards so that Samplitude records 
from the correct input.
Now click on 'Monitor' to activate the volume meter. They should now indicate the levels of your input 
signal. If that is not the case, you will need to control the levels, if necessary, with the help of a mixer 
program that controls the volume of the input and output ports of your soundcard. Such a mixer program 
usually comes with the soundcard. Make sure that the levels are set properly for a good saturation, but 
still reserving room for possible peaks. A good value to set the levels at is -6 dB (the needles point 
vertical).
Now the record session can be started with the 'Record' button. After a couple of seconds click on 'Stop'. 
In the (very rare) case, that the computer is overloaded with the recording process and therefore not react
to the 'Stop' button, the recording can be interrupted with the spacebar. Consider especially during 
recording to RAM that your available memory is also sufficient. Otherwise the computer will swap 
programs to disk, unnecessarily consuming precious resources. Leave the recording window by clicking 
on the 'OK' button. Your recording appears in the virtual project as an object with the wave form 
displayed.
To play back your project you simply press the spacebar or one of the three play buttons from the upper 
toolbar. This will start the playback. If the cursor moves across the sample, you do not hear anything, 
make sure that the audio outputs of the soundcard are connected to an amplifier or directly hooked up 
with the monitor speakers (in case the soundcard has separate speaker outputs).
You can open a 'Play Parameter' window by pressing the 'p' key. In this window you can specify a device
much like in the 'Record' window to set parameters such as the sample rate. Ensure, that your sample is 
played through the right device, if you have installed several cards.

Next you should make a test of recording directly to the hard disk. You will need to select the next two 
tracks with the 'R'-button at the left of the window edge (Pro and Studio version). In the Multimedia 
version simply set the cursor simply behind the first recorded object (left mouse button).
Now open the Record window again with the Record-button. In the settings window select 'HD' instead of 
'RAM'.

If you now press on the 'Record' button, the harddisk recording will start, which can also be observed 
through the activity indicator of the hard disk. Do not be surprised, if during the recording the volume level
display is reacting more slowly. It still indicates the correct volume levels.
If a message should appear with the reference to a conflict between RAM and HD projects, simply click 
on the button 'Create New Project' and confirm the proposed name. This warning always appears if you 



try to mix harddisk (HD) and RAM projects within a track.

Please note, that for a minute of sampling about 10 megabytes hard disk space is required. You therefore 
need to finish the recording accordingly in order not to run out of space. 
Finish the recording with the 'Stop' button and exit out of the recording window by clicking on 'OK'.

The playback can be started and stopped with the spacebar. Now your project should be played direct 
from the hard disk. If you encounter interruptions in the playback or small slopes during the playback, 
follow the steps below to solve these problems:

- Open 'System' in the menu 'Setup'.
- There you will find a section with different buffer sizes. The VIP buffer is responsible for the playback of 
the virtual project. Increase this value e.g. to 16384 or 32768 bytes by clicking on the '+' button. Now the 
playback should work faultlessly. The downside is, that more storage is required now and the cursor 
follows the current position in larger steps (by the size of the buffer). It is important to find the best 
compromise between safety (large buffer) and fast reaction (small buffer). The buffer 'HD Record' is 
responsible for the recording to the harddisk files and should be set to the same value as the VIP buffers.
If the playback from harddisk also works faultlessly, you have successfully mastered the first hurdles in 
the working with Samplitude. If you should have problems with the Quickstart chapter, consult the chapter
'Problem Solutions' at the end of the manual or the detailed descriptions of all functions!
If you are primarily interested in creating and processing multitrack projects, continue to read the next 
paragraph on virtual projects. If your interests are in physical sample editing, refer to the chapter that 
follows for the most important steps.
We recommend in any case however to read through all of the paragraphs, since they discuss many 
tricks and functions!

Virtual projects

Virtual projects (VIP) are the strongest side of Samplitude. Most tasks which occur in the normal 
recording routine are performed in them. Virtual projects allow the combination of unlimited individual 
recordings into complex arrangements in 1-16 tracks. The best of it: all necessary processes (positioning, 
cutting, volume, fades and crossfades) are performed non-destructive, i.e. they do not destroy the original
material but are processed in realtime during playback. To reach the maximum performance, the 
corresponding routines were programmed in highly optimized assembler code. That makes Samplitude a 
an extraordinary and fast program!

First, open a virtual project with the menu 'Project', 'New Project', 'Virtual' or by clicking the 'New Project' 
button and choose '4 Mono tracks' in the dialog box (Pro or Studio version).
A window with 4 empty tracks is opened in which the uppermost track corresponds to the left stereo 
channel. The next track corresponds to the right channel and so on. Record a signal as described before 
in the previous chapter to the first two tracks. You can also integrate ranges from physical samples (RAM 
or HD project) into a VIP:
Arrange the windows of the virtual project (VIP) and the physical samples (RAP or HDP). This is easily 
accomplished through pressing the 'Return' key.
Next, mark a certain area in the sample (or the entire sample with the 'a' key) and pull the area with the 
mouse into the virtual project (Drag & Drop).

Your sample object now appears as a box in one of the virtual tracks. If you activate it with the right 
mouse button, five small black corners, called 'handlers', will appear.
All object functions are executed and set with the right mouse button! First you should move the object 
with the mouse - always, remember to use the right mouse button! Do not click on any of the five 
handlers, but click in the object. If you move the mouse now while holding down the right mouse button, 
you can shift the sample on the time line or between the tracks. Arrangement can hardly be done in a 
more simply way!
To change the length of the object, use the lower handlers at the sample beginning or end. If you have 



simultaneously opened the physical project, you will see a marked area in it, which corresponds exactly to
length of the object. To open the corresponding sample object, a double click with the right mouse button 
on the object will immediately bring up a window with the sample in it. The highlit area indicates the 
position of the object in the physical sample. The volume of the object can be changed with the middle 
handler by decreasing the size of the object. The smaller the object, the softer the volume becomes. You 
can test it by playing back the project.

The two handlers above on the left and on the right are finally for fading in and fading out a sample object.
If they are pulled to the object middle, the object will be faded in and faded out. These effects are also 
calculated in realtime. That means, that they will not physically alter the original material and can easily 
be undone.
In virtual projects (VIP) an UnDo function is always available, which can cancel up to 100 of the last 
changes. Call up the menu 'Edit', 'Undo' or press Ctrl+z. You don't need to be concerned anymore about 
destroying your arrangement inadvertently!
Experiment some with the handlers by creating two more objects. You can either record something else 
and pull some more samples from the physical projects into the VIP, or you can duplicate the objects in 
the VIP as follows: 
Hold the Control-key (Strg) and pull the object with the right mouse button into another track. This will 
create a copy of the original object, which can be placed anywhere in the VIP. This way you can easily 
generate one long drum track from a drum loop, especially with the help of the grid function. By clicking 
on the mouse button you can activate a screen, which causes that object to be positioned exactly on the 
edges of the other objects (Object Grid). 
This creates sample exact passages between the individual objects without having to constantly zoom 
into the object!
There are different grid types, which can be selected in the menu 'Range', 'Grid', 'Grid Type'. You can 
select a grid based on bars for example. This feature is described in chapter 4.5 in more detail.
Now that you have learned the basics of the objects, it is recommended to have a look at the buttons at 
the left edge of each track:

? - This will open the track information dialogue. You can enter a name as well as setting realtime 
functions.
= - Joins two mono tracks. Volume operations will affect both tracks.
M - Mute. This will mute the selected track.
S - Solo. Only this track is played.
L - Lock. Prevents editing with the menu 'Edit' for this track.
V - Volume. Activates the volume curve for this track.
R - Record. Enables this track to the recording.
Besides the buttons above there is also a volume slider situated in the left section, one for each track 
and (for stereo tracks) a panning slider.
Many musicians have already experience with MIDI sequencers. This is why we arranged these buttons 
in a similar way to facilitate a fast introduction.

Activate for example the V-Button:
In virtual projects a freely definable volume curve can be defined for each track ('Volume Rubberband'). 
These volume curves are calculated in realtime and therefore do not change the audio data on the disk. 
To accomplish this a certain processing power is required, which should be available with a 486/66 or 
Pentium. 
By double clicking on the volume curve with the right mouse button a new handler is produced, which can
be freely moved. Another double click on the handler will make it disappear from the curve. Digital mixing 
automation isn't done easier!

The 8 lower left buttons in a VIP store 4 setups (S1...S4 incl. zoom level, cursor position and display 
mode) and 4 zoom levels (Z1...Z4). So you can quickly switch f.e. between a full size display, a 10 
seconds zoom range and a sample exact zooom level for perfect editing!

Another powerful function are virtual crossfades:



If the crossfade mode is activated, overlapping objects within a track can be executed with a realtime 
crossfade.
To accomplish this the back object always forwards the crossfade parameters to the object in the front. 
Select an object and shift it from behind partially over another object. Activate the crossfade editor in the 
'Edit' menu or with the crossfade button. You can select various curve forms for the fade. After leaving the 
editor the crossfade can also be changed with the handlers of the object in the back.
There is also a special auto-crossfade-mode available, which can be activated with the -button. In this 
mode all newly recorded objects will automatically be processed with a standard fade, so that they 
execute a crossfade when overlapped with other objects. This standard fade can be edited in the 
crossfade editor with the buttons 'XXSet/Get Global'. Additionally the crossfade parameters can be 
changed in retrospect with the handlers. 
Please keep in mind, that long crossfades require more than double the processing power of simple 
tracks. After all, two samples are simultaneously played and mixed in realtime. Linear crossfade curves 
save more processing power than non-linear crossfades!

Record-While-Play
With Samplitude Studio playback of existing samples is possible while another one is recorded, if this 
mode is supported by your sound card. In the recording window activate the option 'Record While Play'. 
With this feature Samplitude Studio finally offers the comfort of a digital multitrack recorder.
We therefore recommend the use of sound cards which support the simultaneous recording and playback
of wave files. You can also record through one card while playback is done through a second card. 
However, you may encounter inaccuracies, which have their cause in inexact sample rates of individual 
soundcards. 'Record-While-Play' obviously demands more system resources, processing power and disk 
capacity than the single playback of your samples. If your system should encounter problems with for 
example a playback of 6 tracks while you attempt to record an additional 2, simply mute some of the 
existing tracks to improve the overall performance.

Please make sure, that the VIP and HD buffers are the same and increase them, if necessary!

A Look At the Object Menu

It is probably very helpful to have a look at the Object menu to gain a quick overview of the functions available 
specifically for objects in VIPs. Similar to the introduction on physical sample editing, only the most important function
will be covered.

Please note! The functions to mark ranges and to set cursors as well as the different playback modes will also work 
with virtual projects. A range can quickly be marked with the left mouse button and played with the Space bar, 
manipulating the objects (right mouse button) until the results are really perfect.
The cut functions in the menu Cut will also work with VIPs. They will cut all tracks at the same time, regardless of the 
upper limits of the object. This way a whole verse can be copied from many individual elements and inserted at 
another position. Simply mark a range over the verse, press the c key to copy it and place the cursor at a new 
position. Press v to insert it at that spot. Nothing is more simple!

Grouping Objects

With this function you can group a number of objects. You first have to select all the objects by clicking on them with 
the right mouse button while holding the Shift key pressed. Then activate the group function by clicking on the Group 
Selected button. The grouped objects can then be shifted or copied by pressing the Ctrl key. 

You can also group individual groups. This way you can build complex arrangements from smaller elements without 
loosing track of them. Objects which are based on stereo samples are actually existing of a group of 2 objects which 
are always edited together.
Groups can also be separated with the Ungroup button to create, for example, a mild phase shifting effect from left to 
right or to adjust the volume for the individual tracks to gain a panning effect.

Lock Objects



Once you have place objects in the proper spots you can prevent accidental shifting by locking them in place. Once 
locked, the object displays a diagonal line within the object.

The Hotspot

Objects which do not contain the acoustical peak at the beginning are difficult to integrate in the arrangement using 
the raster option. The hotspot function is the remedy for that type of problem.
Select the desired object and set the cursor to the raster position of your choice. Then select menu Object, Hotspot. 
The object will be lined up to other objects to the new position and not the beginning of it. A typical example of such a 
problem is the sample of a smashed in door in which the actual smashing sound is the most important and not the 
noise of the opening door.

For further details about particular functions, please read the following chapters in the manual.

You should be up and running now. If you ran into problems during Quickstart consult the chapter 
Problem Solutions at the end of the manual. 



Virtual Working

Selection of objects with the mouse
Multiple selection of objects
Unselect objects
Move objects
Edit the borders of objects
Fade In / Fade Out
Object-Volume
Covering objects

General
Virtual projects are one of the most powerful functions of Samplitude.

From many physical projects (RAM and HD samples) a complex arrangement can be made by using 
virtual projects. All interface operations are also virtual, that is, they dont destroy the original samples. You
can experiment with different settings without altering the original sample.

Even though your audio hardware is only capable of putting out audio data in 2 tracks (channels/stereo), 
Samplitude can handle more than 2 tracks in any virtual project (Samplitude-Pro only). As an example, 
you could fade a stereo project and at the same time bring in another stereo track, blending speech with 
music.

Digital processing requires a certain amount of processing power from your computer system. Slower 
machines will limit the number of tracks you will be able to manage. On a typical 486/33 a maximum 
number of four tracks can be mixed and output through the audio outputs without running into problems. A
486/66 or a Pentium processor should handle 8 tracks in 16 bit quality without problems. Another 
important factor to watch out for is the speed of your hard disk.

Here the function of the buttons in the tracks of virtual projects (VIPs):
? - This will open the track information dialog. You can enter a name as well as setting realtime functions.
= - Joins two mono tracks. Volume operations will affect both tracks.
M - Mute. This will mute the selected track.
S - Solo. Only this track is played.
L - Lock. Prevents cutting with the menu 'Cut' for this track.
V - Volume. Activates the volume curve for this track.
R - Record. Enables this track to the recording.
Besides the buttons above there is also a volume slider situated in the left section, one for each track and 
(for stereo tracks) a panning slider.

The 8 lower left buttons in a VIP store 4 setups (S1...S4 incl. zoom level, cursor position and display 
mode) and 4 zoom levels (Z1...Z4). So you can quickly switch f.e. between a full size display, a 10 
seconds zoom range and a sample exact zooom level for perfect editing!

To integrate physical samples into a virtual project, record directly into a VIP using the R-buttons in 
the tracks or follow these steps:

1) Open the RAM or HD project.

2) Mark the complete project as a range (key a) or only the range to be joined in the VIP.

3) Give a name to the range for later identification.

4) Create a new VIP, using the project menu or the corresponding button on the button bar.

5) To position the windows on the screen, press the Enter key.



6) The specified range in the RAM or HD project can be dragged onto the virtual project 
window. To do this click on the physical project range and hold the mouse button. Now drag 
the range onto the virtual project window. You will notice that the range is being pulled to the 
nearest group of tracks (for stereo projects, single track for mono projects). 
After releasing the mouse button the sample range will appear at exactly the same position 
you released the mouse button.

Please note that a VIP is always longer than the samples being shown in it. The first sample may take 
80% of the space. So, producing more samples (ranges) or shifting backwards will scale the graphics 
again.

Manipulating the Display of a VIP

There are two ways of displaying a VIP. The Tab key switches between the display modes. Shift + Tab 
calls an editor to define the display modes. One allows the display of all data and graphics. Another 
allows illustration of only text. The second mode is recommended for use with a large number of projects 
since it is faster in reconstructing the window contents.

VIP objects can also be displayed with different background colors. This will allow you to distinguish 
objects with different color codes. 

To select different colors, follow the steps below:

1) Select the VIP object by clicking on it with the right mouse button.

2) From the Object menu select Object Background Color....

3) Select the desired color and click on OK to return to the project window. The color should 
have changed to the one you selected.



Selecting an object using the mouse
To select an object simply click on it with the right mouse button. You should see 5 small handles that 
appear at the beginning and end of the object and in the middle. If you click on the object again, the 
selection will be revoked. 

The frames around the object will also be inverted if the right mouse button remains being pressed.

If you select an object this way, you will deselect all previous selected objects.

If you double right click on the object, the corresponding physical project (RAM or HD) will be opened. 
The range representing that object is marked at the same time.



Selecting several objects using mouse

Pressing the right mouse button together with the Shift key enables the selection of an object without 
revoking the selection of other objects. 



Unselecting objects

Click the mouse next to an object and all selected objects are unselected.



Move objects
After one or more objects have been selected, they can be moved horizontally (on the time axis ) or 
vertically (in the track number). You will need to click on the object(s) and hold the mouse button. By 
dragging the object(s) you can either shift it to a new position on the time scale or move the object to a 
different track. 

When shifting multiple objects, please keep in mind that the shift can only occur until one of the objects 
reaches its outer limits. In other words, if the first object in the group reaches the beginning of the virtual 
project the shifting will stop at that point.



Changing the beginning and end of objects in VIPs
The two lower handles of an object define the edges of the object. By manipulating the handles you can 
change the beginning and the end of an object. The beginning of the object can be shifted forward or 
backward, when you first click on the front handle and then keep the right mouse button pressed. 

The beginning of the object can only be shifted to the beginning of the physical sample or to the end of 
the object. Respectively, the end of the object can only be shifted as far as to the end of the physical 
samples or the beginning of the object. 



Fade In / Fade Out
The two upper corners of an object are the handles for fading in and fading out. Fading in and out can be 
easily achieved by manipulating those handles. As already explained, this function is performed in real-
time mode. Any alterations you make here will leave the original physical sample unchanged. 

You can specify fades without risking loosing any sample data.

Since real-time fading requires system resources, you might encounter small interruptions during 
playback on slower computers even though Samplitude make use of optimized Assembler programming. 
Should this occur try increasing the VIP buffer values by selecting System... from the Setup menu.



Object-Volume
The volume of any object can be adjusted using the handle in the middle of the object. This function is 
also performed in real-time. If your system cant handle the needed requirements, the physical sample can
be set to the appropriate volume levels using the normalization function.



Covering of objects
On a track (channel), only one object can be played at a time. When an object is shifted and covers a 
certain portion of another object, the invisible portion of the covered object cannot be played.

Shift the object to make the invisible portion of the covered object portion visible and audible.



Raster
Samplitude offers a sophisticated way of positioning objects. An invisible raster helps you (when turned 
on) in shifting objects to exact positions. Please refer to the menu option Range, Raster for further 
explanation of this function.

Object Raster

As explained above, rasters will let you easily shift objects to a specific position. Using this function with 
the Object Raster, you can only shift objects as far as to the beginning, the end or the hotspot of another 
object. The front edge of the object is normally the reference point. A hotspot for the object is only taken 
into account if its already defined. If several objects are selected, they will always be shifted to the front 
edge (or the hotspot) of the object which is selected as the last (the mouse points to this object).

This function will let you rearrange audio patterns easily and quickly by gaining sample exact merge 
points.



When virtual projects are loaded into memory, Samplitude open all physical projects (RAM and HD) which
belong to the VIP first and positions their icons on the screen bottom part of the screen. The window for 
the virtual projects will then be opened.



The Screen of Samplitude

After you have started Samplitude, you will see a window with some information about the program. 

The lower margin shows a bar of buttons, which will be used for positioning sections later on. They are 
operated with the left mouse button. On the upper tool bar youll see some symbols of commands most 
often used.

To have a first look at Samplitude, you should create a project, or load a demo project. To do this, you 
need to select the following menu options: 

From the Project menu, select Open Project... and open the virtual project intro.vip.

You will see a virtual project with different sample objects which are situated along the time axis in the 
tracks.

If you press the Spacebar you will hear the samples displayed on the screen. If you dont hear anything at 
this point, you will need to check out your soundcard and/or sound equipment. Please refer to the chapter
Quickstart for further help.

The project window can be shifted and varied in size. If you change the window size or position, the 
screen will be redrawn. Please note that the title bar contains the file name, the sample resolution and the
sample length. You can calculate the memory size needed in bytes from the sample length, the resolution 
and the channel number.

The icons in the lower section of the screen represent the physical projects bound together in the virtual 
project. The demo version only contains some short RAM-samples.



Definitions

Here are some important definitions of some specific terms, which are frequently used in this manual. 
Please dont skip ahead, even though some might be familiar to you. The terms are used in a special 
context and will not be explained further in this manual.

Familiar terms such as button, window and requester are not explained here. You will find them explained 
in a Windows manual.

            Project  

            View  

            Range  

            Cursor  

            Playback  

            Objects  

            Clip  

Sample
A Sample is a sequence of digitized audio data. It is characterized by its length (the number of sampling 
values) and its sample resolution per sampling value.

Mono
A project containing one sample is called mono. The audio signal of the sample is played through the left 
as well as the right channel of your soundcard. Volume can be controlled for both channels separately by 
the mixer-tool of your sound card.

Stereo
Projects with two samples are called stereo.



Project

A project consists of one or several samples. Samples of one project are always processed together. 
They have the same sampling rate, the same sample value and the same length. Choose the 
corresponding window to access a project. The title bar of the window contains the project name, the 
sample resolution, the sample length and the memory used in kBytes.

To activate a project, just click the mouse on the respective window. To edit samples one by one, stereo 
projects must be divided. Samplitude can handle an unlimited number of projects on the screen.

Different Project Types

Physical projects (RAM- and HD-projects)

In RAM-projects, samples are stored in the memory of the PC. The data files are usually located in the 
directory RAP (RAM-Projects).

Samples of HD-projects are recorded and saved direct in files on the hard disk. These files are normally 
located in the directory HDP (HD-Projects). Only some parts of the samples will be loaded into the 
computers memory. These portions are immediately needed for displaying, processing or playback.

Virtual projects (VIP)

A virtual project is a collection of sections from different samples. It does not contain any individual 
samples. If you sample with a specific sample resolution, that same resolution will be used for playback in
virtual projects. Samples can be processed on an object-oriented basis throughout a virtual object.

The actual audio data is displayed boxes (so-called objects) in their respective tracks (channels).

An object is an image of a sample or of a range marked in the sample. So, an object contains no audio 
data, but references to the physical sample.

You can read details about virtual project processing in the chapter about Object menu.

The corresponding files stored are under the directory VIP (Virtual Projects).



Clip
The clip is a buffer or temporary memory into which samples from a project can be copied, or from which 
samples can be inserted into projects. In addition, the content of the clip can be mixed with the data of a 
project.

The clip has always the same properties as the project from which the data has been taken (sample 
resolution and mono/stereo mode).

The clip is represented on the screen by a window having the word Clip on its title bar. Otherwise, a clip 
is also a project, that means, it can be played, edited and renamed. 



Range
A range a certain portion (part) of the sample marked by you. When a range has been marked, it can be 
played by pressing the space bar. A range is defined by its beginning and its end (horizontal) and by its 
upper and lower edges (vertical).

A range is used on one hand for the specification of parts on which certain operations can be performed 
(such as cutting, inserting, normalizing, fading in/out, shifting upward and deleting).

Another function of a range is the definition of loops considered when samples are played.

The third function is the determination of bounds of sections within which the data is represented 
graphical image. Mainly the upper and lower edges of a range are interpreted here, which is not true for 
all cases with the first group of functions.

Unlimited number of ranges can be specified in a project. Ten of them are activated by the function keys, 
the others by the range-manager. The vertical value of a range can be put to a maximum by selecting 
the option Fix Vertically from the Setup menu. This maximum is pre-adjusted in case of VIPs. 



Cursor
Cursor points (locator points) are used to mark certain positions in the sample. They are generated by a 
single click on the left mouse button on the sample. 

The cursor is a special type of the range, e.g. a range whose beginning is identical with its end. If a cursor
has been defined, it will not be possible, for example, to cut or copy the range. The contents of the 
clipboard, however, can be inserted there.

You can specify as many cursors as you like in a project. Ten of them can be switched to with the number 
keys of the keyboard.

If the cursor has been set and the space bar is pressed, you can hear the portion from the cursor to the 
end of the sample.

Names of cursors and locator points can be seen on the upper edge of the sample and can be shifted.



Sections
Samplitude can display up to three portions of a project at the same time. One section, for example, 
permits the representation of the complete sample, while another section merely shows a small part being
edited. Sections are similar to ranges, since they are defined by their beginning and end and their upper 
and lower edges as well. The length of a section equals the difference between the end and the 
beginning, its height the difference between the upper and lower edges.

The use of several sections allows very efficient work to find loop points.

Active section 
To increase editing speed, some functions that are used more often have been included in the Tool Bar.

Before you can apply any of the functions, you will have to select a specific section or region. This is done
by clicking on the right or lower proportional button (scrollbar) of the section. The color of the sections 
margins will change and it will be the active section from now on.



Range marking
To mark a range (also called area), move the mouse pointer to one of the sections shown and press the 
left mouse button. Keep the button pressed and move the pointer within the section. 

You will see how an inverted rectangle is represented between the start point and the current mouse 
pointer position. Now, release the left mouse button.

The horizontal limits of the chosen range appear in the text line below the title bar.

If you want to mark a different range, simply click on a position outside the inverted range but inside the 
section. The old range disappears, and you can now mark a new range.

If you only want to alter a range already existing (i.e. beginning, end, upper edge or lower edge), click with
the left mouse button inside the existing range. Keep the mouse button pressed and leave the range in 
the direction of the bound to be changed. When you have left the boundary line, this edge (and no other 
but this) will follow the movement of the mouse pointer. Release the mouse button when you have 
reached the position desired.

This is a way of maintaining appropriate bounds and to change the desired edge only.

Samplitude offers you two possibilities:

If you have another section which is not entirely overlaid by the current range, you can click outside the 
range and immediately release the button again. The former range disappears, and a cursor or a very 
small range becomes visible. Now you can define the desired range in the original section.

The other way is simply to press the numerical key 7 (Home) or 1 (End) on the numerical key pad. These
are the commands for Cursor to Start or Cursor to End. The old range disappears and you can define a
new one (The functions Cursor to Start or Cursor to End can also be found in the Range menu).

There is another possibility: 

The limits of the current range can be varied with the keys 4 and 6 on the numerical key pad. Key 4 (as 
well as the cursor key left) moves to the left (beginning of the sample), key 6 (as well as the cursor key 
right) to the right (sample

4 Cursor or range to left

This means that the cursor or the complete range is shifted by a size 1 step to the left. Keeping the key 
pressed for a long time shifts the range further to the left. The shifting velocity increases along with the 
duration of the key actuation. For fine positioning, just release the key and press again. Another shift to 
the left by a size 1 step will occur again.

Ctrl + 4 Range to beginning

The new range now extends from the beginning of the sample to the end of the former range or to the 
former cursor position.

Alt + 4 Cursor to beginning of range

The cursor is positioned at the beginning of the current range.

Shift + Ctrl + 4

The range already marked is folded to the front, which means that the range is shifted left by its own 
length. This function is very useful to find drum loops:

When you have marked a bar in a rhythm sample, the use of this function allows you to mark the following
bar. Consequently, this function eases the work in generating virtual projects.

Page up



The beginning of the range is set to the next zero position, in order to gain cuts or loops with no cracks.

Shift + Page up

The beginning of the range is set to the former zero position, in order to gain cuts or loops with no cracks.

The functions specified above for shifting the range left are also available for shifting to the right direction. 
The above details of functions are similarly applied.

6 Cursor or range to right
Ctrl + 6 Range to end
Alt + 6 Cursor to end of range
Pgdn End of range to right to next zero position
Shift + Ctrl + 6 The range already marked is folded to the end
Shift + Pgdn End of range to left to next zero position

Generally speaking, the direction of movement is specified by keys 4 and 6 on the 
numeric key pad.

Special functions are assigned to Home and End keys:

7 (Home) Cursor to beginning of sample
1 (End) Cursor to end of sample

Ranges can also be shifted using the mouse:

Press and hold the Shift key and then click in the range already marked. By holding the mouse button 
you can shift the marked range either to the left or right, dependent on the movement of the mouse. This 
can be useful, for example, if a loop length already found is to be tested in other positions.

Ranges and cursors can also be saved by means of the menu or a function key. Samplitude is able to 
save an unlimited number of ranges and cursors. These and special functions for defining, varying, and 
using ranges can be found in the Range menu.

A review of all key assignments can be found in the chapter Shortcuts. 



Playing Ranges
To listen to the sample, press the space bar.

There are three playing modes which can be chosen by three buttons on the upper button bar. 

 plays sample once 
 plays sample looped 
 plays sample form the beginning, then loops the range.
If a range has been defined, it will be played from the beginning to the end over and over again. If you 
change the length of a loop or section (range) the results are immediately audible.

If you did not specify a range or cursor position, you will hear your sample from the current cursor position
to the end of the sample. If a cursor position has been defined, the section between this cursor and the 
end of the sample will be repeated. Sample playing can be interrupted by pressing the space bar again. 

You should note that all sample resolutions can be played immediately. The data is converted in real time 
mode, i.e. while playback. This means that the processor is partly occupied with the conversion of the 
data.

If the system has too much data to convert while playing, it is possible that the space bar or the play 
button will not start the playback. Should this occur use the ESC key to interrupt the playback mode.

Output Modes

The output modes can be adjusted in the Play Parameter window ( key p or menu Special..., Play 
Parameter...). You can choose another sampling rate by specifying the sampling rate check marks. 
Notice that not all sound cards support all sampling rates listed. Cards with digital inputs and outputs will 
only offer a sampling rate of 48, 44.1 and 32 kHz.

The driver of the card can be chosen in the Device Window. This is important when you have more than 
one sound card installed in computer.



This button will let you switch between different zooming factors. The length of the section 
displayed is always cut in half. However, the middle of the section is maintained. Exceptions are possible 
if the range is at the beginning or end of the sample. From a certain resolution on, the single sampling 
values are represented individually and separated from each other by vertical gaps.
The lower limits of zooming in are 2 or 3 sampling values. The whole section will be filled with these 
sampling values.

Another way is zooming out of the section. The length of the section is doubled, and its middle 
position is maintained. Exceptions are possible if the section has already covered almost the complete 
sample. The upper limit of zooming out is the complete sample.



The complete sample is displayed in the section.

The horizontal bounds of the current range are used as the beginning and end of the current 
section. The length of the current section is maintained if only one cursor has been defined. However, if 
possible the bounds are chosen in the way that the cursor is in the middle of the section.

The length of the section is chosen in a way that the number of sampling values displayed is 
equal to the number of pixels available in the section.
The middle is maintained.



The section is shifted by half of its length to the left, i.e. toward the beginning. The length of range
is maintained. The middle of the section is moved to its right edge or/and the left edge of the section to its 
middle.

The section is shifted by its full length to the right.

The section is shifted to the beginning of the sample; its left edge is equal to the beginning of the 
sample, the length is maintained.

The section is shifted by half of its length to the right. 

The section is shifted by its full length to the right.

The section is shifted to the end of the sample.



The blue buttons on the bar are used for positioning the sections along the vertical amplitude axis.

The buttons have the same functions as the ones for horizontal shifting and zooming. The difference is in 
the vertical application of their actions.



Defining Sections (lower toolbar)
Sections can be defined by the button bars located on the bottom part of the screen and by proportional 
bars located on the bottom and right edge of the window.

Section to beginning
Section one length left 
Section half of its length left
1 Sample = 1 Pixel in section
Zoom in
Zoom complete range in section
Zoom out
Show complete sample in section
Section half of its length right
Section one length right
Section to end 

Zoom in vertically
Zoom in to verical range borders
Zoom out vertically
Show complete sample vertically

Set section in a VIP to the next/previous object border
Set section to the next/previous cursor



Zoom in vertically
Zoom in to verical range borders
Zoom out vertically
Show complete sample vertically

Set section in a VIP to the next/previous object border
Set section to the next/previous cursor

 Set the zoom depth to 0.1, 1, 10 and 60 seconds



Problems and Solutions

The following are solutions to some common problems. Should your problem persist, please contact the 
distributor or us via CompuServe. Please supply the following information:

- Version of Samplitude
- Where you bought the program
- Configuration of your system (Processor, RAM, hard disk, etc.)
- Sound card configuration (Type, Driver)
- Information on whether other audio components are operating properly

Installation process is interrupted

If the installation process interrupts, but all paths have been specified correctly it is usually an indication 
for either a defective installation diskette or your hard disk simply doesnt have enough space left to install 
Samplitude. Samplitude needs at least 2.5 MB or hard disk space for a proper installation.

Error Please install Samplitude from the original disk!

This error occurs, if the installation of Samplitude on the hard disk is destroyed or some important 
properties of your computer system changed since the installation. Please install Samplitude again from 
the original disk!

Demo-VIPs arent loaded

When trying to load the included demo VIPs Samplitude, reports a load error for the RAM projects (.RAP).

The installation program had difficulties copying the VIPs to their correct directories. One of the reasons 
could be that the directory entered was incorrect or the Windows path was wrong. Also, Samplitude will 
needs to locate the parameter file sam4.ini. If it does not reside in the Windows directory, Samplitude will 
generate an error.

No sound while playing

If you do not hear any sound played, but the cursor still moves through the project you will need to check 
on the following:

- The wrong driver in the Play Parameter Window (key p) has been chosen.

- No Windows driver has been installed for your sound card.

- The volume setting in your soundcards mixer program is set too low.

- Faulty connection of the speakers or the amplifier to the sound card.

A good idea is to check audio playback apart from Samplitude. If there is any doubt about the proper 
soundcard setup, use the Windows Media Player to test the soundcard. By loading a wave file in the 
Media Player and playing it you should be able to receive an audio signal on your soundcards output 
connectors. If you are still having problems, ensure that the driver for your soundcard has been properly 
installed.

Cant open Wave Form Device!

Samplitude informs you that the audio outputs of your soundcard have been opened by another program. 
Make sure the Media Player or another wave player is not loaded. Close the program and try loading 
Samplitude again (or if already loaded, start playback again).

Cant play this wave format!

This message appears when you try to play a wave format which is not supported by your soundcard. 



Because Samplitude requires a 16 bit soundcard, the use of a 8 bit cards causes this message. Another 
reason for this message is that your card doesnt support all sampling rates available in Samplitude. To 
check the capabilities of your soundcard use the standard sampling rates such as 44 kHz, 32 kHz, and 22
kHz.

Short interruptions during playback

After starting playback, especially in case of HD Projects and VIPs, you might encounter short dropouts. 
This usually means that your system (processor or disk) is too slow for the adjusted buffer size and 
sampling rate. Try the following steps:

- Raise the buffer value for RAM, HD or VIP in the dialog window by selecting Setup, System (key y). Higher
buffer values will increase overall performance, but it will also slow down cursor movement and requires 
more RAM memory.

- If it still doesnt work, then you must reduce the sampling rate. Reduce it from 44.1 to 22 kHz. In most 
cases the audio quality is still sufficient (enough for video music arrangement or cassette recording).

- With some sound cards in Windows 95 playback interruptions occur, because virtual memory is activated. 
Deactivate the virtual memory in these cases!

Playing doesnt stop

If you can start playback by pressing the Spacebar, but you are unable to stop it your system might have 
become too busy with the data processing. The only way to stop playback is by pressing the ESC key. 
This is the only time playback can be interrupted by pressing the ESC key.

Maximum achievable number of tracks fluctuates

It can happen that the maximum achievable number of tracks on a computer turns out different from time 
to time. Here are a few causes:

Smartdrive Cache:    
By default Windows uses the hard disks caching utility 'Smartdrive' which keeps often used 
portions of the hard disk in the physical RAM of the computer. This can also be a benefit for 
working with Samplitude, since certain detail tasks will run faster. However, if used in 
conjunction with a slower processor, the results of the cache will let you play back 8 tracks 
without any problems; the problems start, when the project is started from the beginning. The 
cache will not be utilized and the system is overloaded.
This behavior can be seen especially with Windows NT and Windows 95 since the cache 
operates more 'intelligent'. 
If needed, simply disable the cache.

Hard disk is fragmented:
Eliminate the fragmentation of your hard disk with a utility program such as PC Tools, Norton 
Utilities or simply the 'defrag' utility supplied with MS-DOS 6.2 and later.

Virtual Memory:
Windows uses virtual memory to expand the physical RAM. However, that leads to a big 
slowdown because the memory contents must first be loaded from the disk. Make sure that 
Samplitude does not use more RAM than is physically installed in your system!    This is 
especially important when deciding on different buffer sizes. 
Virtual memory can be completely disabled in Windows. If you have difficulties with your system,
this is recommended.

No volume level while recording

If the volume level meters do not show the audio signal check the following:



- The wrong soundcard has been selected for recording.

- No Windows driver has been installed for your soundcard.

- The input channels volume (micro or Aux) in the mixer of the soundcard has been set too low.

- Connections to the inputs of your soundcard are defective.

Please make sure that the Monitor option has been turned on. The meters will only indicate incoming 
audio signal if they are turned on.

Interruptions while recording

If you encounter dropouts during recording (especially recording to a hard disk file), but the included 
demo samples play without problems, you might need to increase the recording buffers. 
To increase the buffers, select Setup, System (shortcut y) and adjust the values in the HD Record Buffer 
dialog box. If this doesnt remedy the problem you will need to select a lower sample rate (such as 22 
kHz).

Recording doesnt stop

If you are not able to interrupt the recording session by pressing the Spacebar your system is overloaded.
To stop the recording simply click on the right mouse button. Check the recorded project before continuing
to edit it. It might be missing some portions of the recording. 

Write error during recording

Samplitude will generate an error if you are recording audio and your hard disk is too full. You might 
encounter this error message also if the recording buffers in the system setup are to small. 

Mediafiles not in sync

Should you encounter delays in playing media files in sync with your digital audio you can adjust the 
playback by specifying a correction factor FX in the menu Project, MIDI/Video Link.... See the description 
on the menu option in this manual ot the next paragraphs.

Delays while Direct Synchronization with Q-Trax, Evolution or MIDI-Connections

It is possible, that you get small delays while playback between Samplitude and Evolution or MIDI-
Connections if Direct Synchronization is active.
These delays are the result of an inaccurate sample rate of the sound card. 
Try to find the correct sample rate in Samplitude, to compensate the delays:
- Load a large MIDI song in Evolution or MIDI-Connections (duration 2 minutes or more)
- Make a recording of the whole song in Samplitude as hard disk project
- Open the dialog Snap Definition and set Fixed bar snap to the bpm value of the MIDI song, e.g. 110
- Set Units of Measurement to Bars/Beats
- Activate the grid with the # key
- Open the Play Parameter window with the P key
- Look for a distinctive beat at the end of the song in the sequenzer, e.g. at bar 100, beat 1
- Set the cursor to this beat and zoom in Samplitude until you see the single beats
- Now change the sample rate in Samplitude in 1 Hz steps until the grid matches the beat
So you can find the sample rate your sound card is really playing. Use this rate for recording and 
playback now!

If your sound card plays now at a wrong sample rate or the driver does not accept the new sample rate, 
you can calculate the FX factor = new rate (f.e. 44080) / old rate (f.e. 44100) = 0.9995.
Then type in this factor in the System dialog (key y) FX and the old rate, e.g. 44100 Hz.
This has also the advantage, that the FX factor can be more exact (16 digits) then the sample rate (1 Hz 
steps) !



The same procedure can also be useful to compensate problems with external synchronization in 
Samplitude Studio or with MIDI/Video Link.

Problems with external synchronization (Studio version)

To accomplish a perfect external synchronization a powerful computer is required. A system for example, 
which operates already at the limit and does not react to mouse clicks during playback anymore, will also 
have problems with external synchronization.    
Therefore make sure that your computer has sufficient free overhead e.g. through reduction of track 
numbers or the sample rate, or increase the buffer sizes.
It is also necessary to know, that Samplitude in slave mode can only synchronize to the start of the 
playback or recording. A main cause is the missing frequency corrections (Word-Clock-Rate or similar) of 
PC soundcards. That is, however, no problem if you synchronize to digitally controlled devices such as 
sequencer programs, DAT's, ADAT or VCR's. There are practically no speed variations based on the 
technical concepts used with this type of equipment. 
You can run into bigger problems with analog devices that have a big variation in playback speed. 
Samplitude is not capable to follow and the result is small delays between the material located on the 
analog machine and Samplitude.
When ever possible, try to use Samplitude as master for synchronization, because the sync output is 
directly couppled to the Wave output of the sound card! 

To guarantee a flawless synchronization in slave mode you must first make sure that the start of 
Samplitude project (Pos1) needs to be exactly lined up to the external device. This can be done by 
applying a SMPTE offset in VIP. 
In principle recording and playback should be done in the same synchronization mode (SMPTE, MC, 
master or slave) to prevent variations through different timer settings at the beginning.
For analog devices such as multitrack recorders a frame preroll of approx. 30 frames has shown excellent
results. Samplitude will wait for the first 30 frames before the synchronization is started. This can avoid a 
faulty synchronization during the first phases of linking up the different devices.
If you need to position your material in the middle of a project, you can, however, encounter small delays. 
This is because soundcards often do not observe the specified sample rate which is used for exact 
positioning. 
This problem can be solved by entering a correction factor called 'FX'. The sample rate is multiplied by 
this factor to counter inaccuracies when placing the audio material.

Please try the following steps:
- Ensure that the start perfectly works from the beginning of the project (cursor Pos1).
- Next, set a cursor shortly before the end of the project.
- Select slightly different FX settings (e.g. 1.0001, 0.9999...) and start from the different cursor positions, 
until a perfect synchronization is reached.

Now you can start from each point within the project without having delays introduced. The once found FX
value can be applied for all other projects and does not have to be determined again!

On some computers the 32 Bit disk access caused problems with external sync. Deactivate the 32 bit 
access in these cases!



A few Tricks
A few tricks that help make working with Samplitude an ease:

- Using the Return key you can arrange all windows in comfortable way.
- The a key will select the complete sample as a range.

- With the keys Home and End you can set the cursor to the beginning or end; all marked ranges will
disappear.

- A range can be selected from one exact cursor position to the next by clicking on the cursor marker
above the wave form. Next, hold the Shift key and click on the second cursor marker.

- By using the Shift + mouse click and movement a range can be shifted.

- Shift + Ctrl + Cursor keys will flip a range to the right or left. This is a good way of testing a loop at
a different position.

- Objects in virtual projects can be displayed in two different modes. By pressing the Tab key you 
alternate between the modes. Pressing Shift + Tab will open a dialog window in which you can set 
the parameters of the display modes.

- By using Ctrl + right mouse button click on an object you can easily copy it in virtual projects.

- By double-clicking with the right mouse button on an object in a virtual project you can open 
the corresponding physical project (RAM or HD).

- By double-clicking with the right mouse button on the volume curve in a virtual project you can 
create and delete volume handles. Activate the volume curves with the V-button in each track of 
the VIP!

- Change the function of the mouse buttons in VIPs with the menu Setup > Mouse Mode!

- To calculate the tempo (bpm) of a marked range open the menu Range > Snap Definitions. 
Then type in the number of beats of your range in section Free Bar Snap and click on the Get 
Range button. Then read the tempo value in the BPM display!

- Use the function Lock Objects in menu Object to prevent objects from unintentional moving in 
multitrack VIPs!

Please refer to the Keyboard Shortcuts at the end of the manual for a quick and easy way of working 
with the most important functions in Samplitude.



Keyboard Shortcuts and Mousebuttons

General

a Range all
b Split range into 3 views
b + Shift Display gets 1 view
c or c+CtrlCopy range
c + Shift Copy As
e New VIP
f Fade In/Out
g Synchronization
h Close all Windows
i Project Information
i + Ctrl Import Sample
l Load RAM-project
l +Shift Load HD-project
n Normalize
o Load virtual project
p Play parameter
r Record Dialog
r + Ctrl Raster on/off
r + Shift Raster definition
s Save project
s+Shift Save project with new name
t Split objects
v or v+Ctrl Insert Clipboard 
w Load wave
x or x+CtrlCut range
y System preferences
Tab Toggle object drawmode
Tab+Shft Define object drawmode
Space Playback on/off
Enter Arrange windows
Esc Abort playback, recording and physical sample manipulations
Del Delete range
Del+Ctrl Delete selected objects
Ctrl + z Undo
Ctrl + a Redo
Backspace Restart Playback
Insert Activate Scrubbing mode
# switch Grid on/off

Range

Cursor left or 4 on numeric block:
Switch Range 1 sample to the left

+Ctrl Range to beginning of the project
+Alt Cursor to beginning of the range
+Shift+Ctrl Flip range left

Cursor right or 6 on numeric block:
Switch range 1 sample to the right

+Ctrl Range to end of of project
+Alt Cursor to end of range
+Shift+Ctrl Flip range right

Home Cursor to beginning of project
End Cursor to end of project
PgUp Range start to next zero crossing
PgUp+Shift Range start to previous zero
 crossing



PgDn Range end to next zero crossing
PgDn+Shift Range end to previous zero 

crossing

Cursor up Zoom in vertically in VIPs

Cursor down Zoom out vertically in VIPs

/ * - + keys on numeric block: Move range
borders dependend on zoom level

Function keys

1-10 Get range 1-10
1-10+ShiftStore range 1-10
+ Shift + Ctrl Get range length
F11 Store range with new name

Keypad 0-9 (not numeric block!):
Get Cursor 1...10

+Shift Store Cursor 1 bis 10
+ Alt Store Cursor while playback
? Store Cursor with new name

Mouse

Left Mouse Button:
Mark range

+Shift Move range

Left Double-Click in range:
 Section to range borders

Left Double-Click outside range:
 Zoom out

Right Mouse Button:
Abort recording

Select, Move and Manipulate objects in VIP:
+ Shift Multiple selection
+ Ctrl Duplicate object
+Ctrl+Shift Multiple duplication of objects
+ m Move all objects behind cursor position in VIP

Right + Left mouse button: Opens object editor in VIP






